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1 Примеры решения задач анализа, проектирования и
оптимизация конструкций ракетно-космической техники в
среде MSC.Patran/MSC.Nastran

Примеры решения задач, представленные в данной главе, предназначены для

ознакомления с приемами моделирования и расчетами разных типов ракетно-космических

конструкций в среде программного продукта MSC.Patran/MSC.Nastran. Кроме того, эти

задачи характерны для всех этапов конечно-элементного проектирования ракетно-

космических конструкций. При решении этих задач могут быть полезны издания [5, 6 ,7].

Пример решения задачи №1 “Моделирование и статический расчет пластинчатой

конструкции с использованием MSC.Patran/MSC.Nastran” позволяет на простом примере

освоить общую последовательность работы при моделировании и статическом расчете,

знакомит с универсальным конечным элементом оболочки Shell.

Пример решения задачи №2 “Моделирование и статический расчет объемных

силовых элементов конструкции с использованием MSC.Patran/MSC.Nastran” служит для

приобретения навыков моделирования объемных тел в препроцессоре Patran с помощью

конечных элементов типа Solid.

Пример решения задачи №3 “Моделирование ферменных и рамных силовых

элементов конструкции с использованием MSC.Patran/MSC.Nastran и расчет на

устойчивость” знакомит с моделированием ферменных и рамных конструкций балочными

конечными элементами Beam, элементами сосредоточенной массы Mass и выполнением

расчетов потери устойчивости конструкции в линейной постановке (Buckling).

Пример решения задачи №4 “Моделирование и расчет конструкции стрингерного

отсека ракеты-носителя в среде MSC.Patran/MSC.Nastran” знакомит с моделированием

конструкции типового стрингерного отсека ракеты-носителя. В этой работе выполняются

расчеты напряженно-деформированного состояния и потери устойчивости в линейной

постановке.

Пример решения задачи №5 “Проектирование конструкции углесотопластикового

головного обтекателя ракеты-носителя в среде MSC.Patran/MSC.Nastran”. Целью данной

работы является моделирование конструкции головного обтекателя ракеты-носителя с

использованием слоистого конечного элемента типа Laminate, выполнение расчетов

напряженно-деформированного состояния, потери устойчивости конструкции в линейной

постановке, частот и форм собственных колебаний. Выполняется подбор числа слоев

однонаправленного углепластика в несущих слоях обтекателя по условиям прочности.
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Пример решения задачи №6 “Моделирование наезда автомобиля на препятствие”.

Цель работы рассчитать перемещение несущей конструкции автомобиля при наезде на

неровность дороги.

Пример решения задачи №7 “ Моделирование силовой работы фланцевого

соединения двух стрингерных отсеков с учетом контакта между фланцами ”. Цель работы

– познакомить студента с контактными задачами, а также изучить специфику работы

фланцевого соединения, в частности конфигурацию зоны контакта между фланцами и

особенности передачи сил через фланцевое соединение.
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1.1. Пример решения задачи №1 “Моделирование и статический
расчет пластинчатой конструкции с использованием
MSC.Patran/MCS.Nastran

Главная цель при решении данной задачи - освоить общую последовательность

действий при моделировании конструкции в MSC.Patran/MSC.Nastran. Поэтому в данной

работе будет рассматриваться весьма простая конструкция – прямоугольная пластинка c

отверстием.

1.1.1 Описание конструкции
Рассматриваемая конструкция представляет собой прямоугольную пластинку с

отверстием из алюминиевого сплава размером a x b и толщиной t. С одной стороны

пластинка заделана (рис. 2.1.1). К стороне, противоположной заделке, приложена сила Р,

равномерно распределенная по стороне. Величины a, b, t и P для разных вариантов

приведены в табл. 2.1.1.

Требуется рассчитать поведение данной конструкции, предположив, что

перемещения точек конструкции малы (отсутствие геометрической нелинейности) и

материал работает в пределах линейного участка диаграммы напряжения-деформации

(отсутствие физической нелинейности).

При таких допущениях можно исследовать поведение конструкции с помощью

решателя Линейная статика. Данный решатель является наиболее простым из всех

алгоритмов, реализованных в методе конечных элементов, и представляет собой решение

системы линейных уравнений метода перемещений :

[К]{u} = {P}, (1)

где [К] - матрица жесткости; {P} - вектор узловых сил; {u} - вектор перемещений.

Составление и решение этой системы уравнений рассматривается в курсах

“Строительная механика” и “Прочность”.
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Рис. 2.1.1 Рассматриваемая конструкция

Таблица 2.1.1. Значение параметров конструкции для разных вариантов задания
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1 100 60 4 1000
2 100 50 4 800
3 200 60 5 2000
4 100 20 6 1000
5 300 120 10 7000
6 100 70 5 1500
7 100 80 4 1000
8 250 50 6 500
9 100 40 4 700
10 150 105 4 2000
11 100 80 2 1000
12 200 180 6 5000
13 300 30 8
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10000

1.1.2 Конечный элемент тонкой изгибной оболочки типа Shell
Для моделирования пластинки с отверстием используем конечный элемент Shell.

Элемент Shell может воспринимать мембранную нагрузку, сдвиг в плоскости

оболочки, поперечный сдвиг и изгиб. Этот элемент применяется для моделирования

конструкций, состоящих из тонких пластин и оболочек.

1.1.3 Создание базы данных задачи
Для того чтобы начать работу в системе MSC.Patran нужно открыть базу данных, в

которой будет храниться вся информация о Вашей задаче. Для этого нужно выполнить
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команду главного меню File>New. В появившемся окне (рис. 2.1.2) требуется задать

следующую информацию:

 В поле “имя файла” набрать имя файла, в котором будет располагаться база

данных Вашей задачи. Файл имеет расширение .db;

 В поле “Папка”, если не установлено, набрать адрес файла (путь директории

на диске), где будет помещен созданный файл;

 Для исполнения команды – нажать клавишу ОК.

Рис. 2.1.2. Окно создания базы данных задачи

1.1.4 Геометрическое моделирование
Геометрическая модель в современных конечно-элементных системах

используется для автоматизации процесса создания модели. Это достигается благодаря

тому, что в препроцессорах реализованы алгоритмы автоматического разбиения

геометрических объектов (кривых, поверхностей, объемов) на конечные элементы.

Геометрическая модель может быть импортирована в Patran из CAD-систем или

сделана средствами самого препроцессора. В данном пособии геометрические модели

будем создавать средствами Patran.

Поскольку наша конструкция представляет собой тонкую пластинку, ее можно

моделировать оболочечными элементами Shell. На оболочечные элементы в программе

Patran легче всего можно разбить поверхности. Таким образом, геометрическая модель

нашей конструкции будет представлять собой прямоугольную поверхность с отверстием.
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Программа Patran предоставляет пользователю много возможностей для создания

поверхностей. Воспользуемся одним из подходящих в данном конкретном случае

способов.

1. Создадим четыре угловые точки и центр отверстия пластинки, для чего нужно

войти в окно приложения Geometry, нажав клавишу , (рис. 2.1.3) и вызвать

окно команды Create>Point>XYZ. Нужная команда набирается в выпадающих

меню опций Action, Object, Method.

Рис. 2.1.3. Окно команды создания точек по координатам Create>Point>XYZ

Эта команда реализует один из возможных способов задания точек - XYZ. В поле

Point Coordinates List в квадратных скобках задаются координаты X, Y, Z точек,

разделенные либо пробелами, либо запятыми. Номер создаваемой точки система

предлагает в поле Point ID List. Создание каждой точки происходит после правильного

ввода всех необходимых данных, если включена опция Auto Execute. В противном случае

– после нажатия клавиши Apply. Создайте угловые точки пластины и точку центра

отверстия. Можно вывести на экран их номера, нажав на клавишу Show labels панели

инструментов.

2. Геометрическую модель предлагается сделать в виде плоской поверхности,

ограниченной кривыми. Для создания такой поверхности в системе Patran требуется

создать кривые по внешним границам поверхности и по границам отверстия. После этого

нужно объединить кривые по внешним границам и по границам отверстия в составные

замкнутые контуры. Ссылаясь на эти контуры создать поверхность пластинки. Это можно

сделать так:
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 Для создания линий внешнего контура в приложении  вызвать окно

команды Create>Curve>Points (рис. 2.1.4). В полях Starting point и Ending point

указать начальную и конечную точку создаваемой линии. Выбор точек

осуществляется либо с помощью мыши, либо ручным вводом с клавиатуры номера

точки в поля Starting Point List и Ending Point List. Номер создаваемой кривой

система сама предлагает в позиции Curve ID List. Выполнить команду, нажав

клавишу Apply.

Рис. 2.1.4. Окно создания линий внешнего контура пластины

 Для создания кривой внутреннего контура в приложении  вызвать окно

команды Create>Curve>2DCircle. В поле Coordinate Plane List указать плоскость, в

которой будет построена окружность. В примере на рис. 2.1.5 плоскость

определена 3-й осью (Z) 0-ой (базовой) системы координат. Это означает, что

окружность будет лежать в плоскости, перпендикулярной этой оси. В поле Input

Radius укажите радиус окружности, а в поле Center Point List – точку в центре

окружности. Выполнить команду, нажав клавишу Apply.

 Для создания внешнего контура в приложении  выполнить команду

Create>Curve>Chain (рис. 2.1.6). В поле Curve List укажите кривые внешнего

контура. Внутренний контур объединять не нужно, поскольку он и так состоит из

одной кривой. Выполнить команду, нажав клавишу Apply.
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Рис. 2.1.5. Окно команды создания окружности Create>Curve>2DCircle

Рис. 2.1.6. Окно команды объединения линий в одну составную кривую

Create>Curve>Chain

 Для создания поверхности в приложении  вызвать окно команды

Create>Surface>Trimmed (рис. 2.1.7). В поле Outer Loop List укажите кривую

внешнего контура, а в поле Inner Loop List –  кривую внутреннего контура.
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Рис.2.1.7. Окно команды создания плоской поверхности, ограниченной кривыми,

Create>Surface>Trimmed

В результате на экране появится поверхность, ограниченная кривыми с отверстием

внутри.

Для того чтобы посмотреть номера поверхности, кривых и точек, нажмите мышкой

на клавишу  (Label Control) панели инструментов в правом верхнем углу экрана. В

появившемся меню (рис. 2.1.8) щелкните по соответствующей клавише.

Рис. 2.1.8. Панель визуализации идентификаторов объектов

Клавиши панели означают следующее:

 - показать идентификаторы всех объектов (All Labels);

 - показать идентификаторы всех геометрических объектов(All Geometry);

 - показать идентификаторы всех объектов конечно-элементной модели (All

Fem);

 - показать идентификаторы точек (Point);

- показать идентификаторы кривых (Curve);

- показать идентификаторы поверхностей (Surface);
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- показать идентификаторы солидов (Solid);

- показать идентификаторы узлов (Node);

- показать идентификаторы элементов (Element).

1.1.5 Задание характеристик конструкционных материалов и свойств
элементов

Характеристики материалов задаются в окне приложения , (рис. 2.1.9).

Рис. 2.1.9. Окно команды создания материалов Create>Isotropic>Manual Input

В этом окне для задания изотропного материала пластинки выберем команду

Create>Isotropic>Manual Input. В поле Material Name нужно задать имя материала.

Нажатием клавиши Input Properties вызвать окно задания характеристик материалов

(рис. 2.1.10)
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Рис. 2.1.10. Окно задания характеристик материалов

В этом окне можно задать упругие характеристики материала, коэффициенты

теплового расширения и теплопроводности, а также плотность, демпфирование и многое

другое. Для линейного статического расчета в опции Constitutive Model нужно выбрать

линейно-упругий тип материала Linear Elastic. Далее задать модуль упругости (Elastic

Modulus), коэффициент Пуассона (Poisson Ratio). В позиции Density можно задать

плотность материала. В окне (рис. 2.1.10) после ввода данных не забудьте нажать ОК, а в

окне создания материалов – Apply.

Следующим шагом создания конечно-элементной модели является задание свойств

конечных элементов (Property), где вводятся главным образом геометрические

характеристики элементов и область применения свойства. Свойства каждого типа

элементов содержат свой набор характеристик. Так, геометрия оболочечных элементов

Shell характеризуется толщиной оболочки, а балочных элементов Beam - площадью

поперечного сечения, моментами инерции поперечного сечения и т.д.

Нажатием клавиши  вызовем окно приложения Property (рис. 2.1.11) и

вызовем команду Create>2D>Shell. В поле Property Set Name нужно задать имя

создаваемого свойства.
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Рис.2.1.11. Окно создания свойств элементов

При нажатии клавиши Input Properties появляется окно задания значений свойств

элементов (рис. 2.1.12). Для элементов тонкой изгибной оболочки задаются материал

(поле Material name) и толщина оболочки (поле Thickness). Остальные поля в этой работе

задавать не нужно. Выполните команду – ОК.
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Рис. 2.1.12. Окно задания значений свойств конечного элемента Shell

В поле Select members окна создания свойств элемента (рис. 2.1.11) нужно задать

область применения этих свойств. Поместите курсор в это поле, и затем укажите

курсором мышки на поверхность пластинки. Выполните команду – Apply.

1.1.6 Создание конечно-элементной сетки
Размер конечного элемента в этой задаче рекомендуется выбрать такой, чтобы

каждая сторона поверхности была разбита не менее чем на 10 элементов. Данная

рекомендация основана на двух соображениях. Во-первых, большее количество элементов

не даст существенного увеличения точности в данной задаче. Во-вторых, брать меньшее

количество элементов нецелесообразно, так как в такой маленькой задаче экономить не

имеет смысла.

Для создания конечных элементов на поверхности необходимо выполнить

следующие действия.

1. Указать размер элементов. Войти в приложение Elements, нажав клавишу .

Вызвать окно команды Create>Mesh Seed>Uniform (рис. 2.1.13). Здесь можно

задать либо число элементов вдоль кривой (опция Number of elements) либо размер

элементов (опция Element length). Указав один из этих параметров, в поле Curve list

следует указать (выбрать мышкой) к какой кривой (Curve) это относится.

Выполнить команду - Apply. Таким образом назначить размеры элементов для всех

кривых поверхности пластинки.
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Рис. 2.1.13. Окно задания количества элементов на одной из сторон поверхности

пластинки

2. Разбить на конечные элементы поверхность пластинки. Это можно сделать в

приложении Elements с помощью команды Create>Mesh>Surface (рис. 2.1.14)

следующим образом:

 Щелкнув мышкой в поле Select Surface ввести идентификатор поверхности пластинки

– или набрать номер поверхности или указав ее мышкой на экране;

 Установить опцию Elem Shape в положение Quad, так как разбивать пластинку будем

на четырехугольные элементы;

 Установить опцию Mesher в положение Paver. Этот алгоритм разбиения способен

создать сетку на поверхностях любой сложности. Алгоритм IsoMesh может разбивать

только топологически четырехугольные или треугольные области;

 Установить опцию Topology в положение Quad4, так как элементы будут

четырехузловыми. В полях Node и Element система показывает, с какого значения она

начнет нумеровать новые узлы и элементы при выполнении этой команды;

 Размер элемента внутри поверхности определяется параметром Global Edge Length.

Для этой задачи рекомендуется отключить автоматическое вычисление значения этого

параметра (опция Automatic Calculation) и задать это значение в поле Value примерно

равным размеру элементов вдоль границ;

 Перед выполнением команды (нажатие клавиши Apply) рекомендуется сохранять

модель, потому что в случае неправильного указания размера конечного элемента,
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элементов на поверхности может оказаться слишком много и компьютер повиснет.

Сохранение модели осуществляется командой File>Save главного меню.

В результате выполнения команды на экране появится КЭ-модель. Примерный вид

модели пластинки приведен на рис. 2.1.15.

Для разных размеров элементов по границам и внутри поверхности получаются

разные конечно-элементные сетки. Наиболее точные результаты будут получаться, если

все оболочечные конечные элементы по форме будут близки к квадратной. Меняя

размеры элементов вдоль границ и внутри поверхности, постарайтесь добиться, чтобы

конечные элементы по возможности имели правильную форму (отношение длины к

ширине элемента меньше 2, отклонение углов от прямого угла не более 30).

Рис. 2.1.14. Окно создания сетки конечных элементов
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Рис. 2.1.15. Конечно-элементная модель пластинки с отверстием

1.1.7 Задание граничных условий
Граничные условия по физическому воздействию разделяются:

 на силы и моменты в виде сосредоточенных и распределенных по длине и площади

нагрузок;

 заданные перемещения;

 кинематические воздействия – ускорения, скорости и перемещения;

 тепловые воздействия в виде температуры и теплового потока.

По способу приложения к объектам модели нагрузки классифицируются как:

 объемные;

 узловые;

 элементные.

Расчет может проводиться для сложного сочетания граничных условий.

Граничные условия в системе MSC.Nastran можно разделить на нагрузки и

закрепления. Нагрузки преобразуются в компоненты вектора узловых сил (вектор Р в

уравнении (1)), а закрепления являются дополнительным уравнением, исключающим

закрепляемые степени свободы из расчета. Например, перемещение по какой либо

степени свободы приравнивается нулю. К закреплениям относятся заданные

перемещения, заданные поля температур в задаче теплопроводности и др. Нагрузки могут

задаваться в любой удобной системе координат, а закрепления – только в системе

координат узлов модели, оси которой совпадают со степенями свободы узлов в расчете. В

связи с этим мы будем разделять граничные условия на закрепления и нагрузки, хотя в

системе MSC.Patran они и задаются одним приложением.



19

Граничные условия задаются в приложении Loads/BCs (клавиша ).

Создадим закрепления вдоль одной стороны пластинки с помощью команды

Create>Displacement>Nodal (рис. 2.1.16):

 в поле New Set Name задайте имя закрепления;

 клавишей Input Data вызовите окно задания величины заданных перемещений

(рис. 2.1.17). В поле Translations следует ввести вектор поступательных

перемещений, состоящий из трех компонентов, разделенных пробелами или

запятыми и объединенных в угловые скобки. В поле Rotations следует ввести

вектор поворотов в том же формате. Заделке соответствует закрепление по всем

степеням свободы и в этом случае оба вектора, определяющие заданные

перемещения, примут вид “< 0, 0, 0 >”. Если нужно задать перемещения не по

всем степеням свободы узлов, то значение перемещения по незакрепляемым

степеням свободы нужно пропустить (например, < 0,  , 0 >). Вернитесь в окно

приложения Loads/BCs, нажав клавишу ОК;

 клавишей Application Region вызовите окно задания области применения

граничного условия (рис. 2.1.18). В нашем случае мы должны задать

перемещения для узлов, лежащих на одной из граней поверхности пластинки.

Это можно сделать либо выбрав опцию Geometry и указав в поле Select

Geometry Entities грань поверхности, либо выбрав опцию FEM (английская

аббревиатура от “конечно-элементная модель”) и указав в поле Select Nodes

узлы, лежащие на грани поверхности. Выполнить команду, нажав клавишу

Apply.
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Рис. 2.1.16. Окно команды Create>Displacement>Nodal приложения создания

граничных условий Loads/BCs

Рис. 2.1.17. Окно задания величины вынужденных перемещений
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Рис. 2.1.18. Окно задания области применения граничного условия

Приложим к нашей конструкции действующую силу. Поскольку сила распределена

по стороне пластинки, то ее необходимо распределить между узлами, лежащими на

данной стороне. Для того чтобы сила распределилась равномерно, в каждый узел на

стороне надо приложить долю силы, равную P/nэлем, где nэлем – число элементов вдоль

стороны. В угловые же узлы должны быть приложены силы P/(2nэлем).

Зададим силу вдоль стороны пластинки, противоположной закрепленной, с

помощью команды Create>Force>Nodal, (рис. 2.1.19). Это делается подобно заданию

заданных перемещений. Только вместо векторов перемещений задаются векторы сил.
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Рис. 2.1.19. Окно команды Create>Force>Nodal задания нагрузок в приложении

Loads/BCs

Совокупность граничных условий, описывающих условия функционирования

конструкции в какой-либо ситуации, называются случаем нагружения. Все созданные

граничные условия помещаются в случай нагружения с именем Default (по умолчанию).

На практике часто приходится исследовать поведение конструкции для нескольких

случаев нагружения, каждый из которых характеризуется своими нагрузками и своими

закреплениями. Для того чтобы не создавать для каждого случая нагружения модель со

своими закреплениями и нагрузками модель может содержать несколько случаев

нагружения. Посмотреть состав этого случая нагружения или создать другие случаи

нагружения можно с помощью приложения Load Cases (клавиша ).

1.1.8 Запуск на расчет
Запуск на расчет выполняется в окне приложения Analysis (рис. 2.1.20), которое

открывается нажатием клавиши , командой Analyze>Entire Modal>Full Run. Вид

анализа выбирается с помощью клавиши Solution type (рис. 2.1.21).. При решении этой

задачи мы считаем, что в материале нет пластических деформаций, перемещения точек

конструкции малы и существенно не изменяют геометрию конструкции. Нагрузка не
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меняется во времени. Такой ситуации соответствует вид анализа Linear Static (линейная

статика). Клавиша Subcases позволяет настроить расчетный случай (выбор случая

нагружения, набора выдаваемых результатов и др.), а клавиша Select Subcases позволяет

выбрать расчетный случай (случаи) для расчета. Для случая нагружения Default

расчетный случай настраивается и выбирается по умолчанию. Остальные клавиши дают

доступ к различным опциям, в которых здесь нет необходимости разбираться, поскольку

их значения по умолчанию подходят в нашем случае.

После нажатия клавиши Apply происходит следующее:

 Patran генерирует файл задания на расчет для системы конечно-элементного

анализа MSC.Nastran;

 Система MSC.Nastran запускается и выполняет расчет в соответствии с заданием

на расчет. В результате расчета создается файл (в нашем случае с расширением

.xdb), содержащий результаты расчета.

Для того чтобы посмотреть результаты в системе Patran нужно присоединить файл

результатов к базе данных Patran-а. Это можно сделать с помощью команды

Access Result Data>Attach XDB>Result Entities. Здесь нужно указать файл с

результатами с помощью клавиши Select Result File и нажать клавишу Apply.
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Рис. 2.1.20. Окно команды Analyze>Entire Modal>Full Run приложения Analysis

Рис. 2.1.21. Окно выбора вида анализа
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1.1.9 Просмотр результатов расчета
В результате расчета конструкции MSC.Nastran получает различную информацию,

характеризующую поведение конструкции. Эта информация, полученная для одного

случая нагружения, объединяется в один Result Case (множество, совокупность

результатов расчета). Result Case содержит разные виды результатов (например,

перемещения всех точек конструкции – один вид результатов, эквивалентные напряжения

во всех элементах – другой).

Виды результатов могут быть скалярными и векторными: содержащие скалярную

информацию и трехмерные векторы. Скалярные виды результатов обычно отображают

заливкой цветом. Векторные виды результатов обычно отображают в виде деформаций

или маркеров.

Некоторые виды результатов приведены в табл. 2.1.2.

Таблица 2.1.2. Виды результатов расчета для конечного элемента Shell

Вид результата Тип данных Компоненты
Constraints
Force,
Transnational
(вектор реакций
в опорах)

Узловые Силы реакций
по осям X, Y, Z

Displacements,
Transnational
(вектор
поступательных
перемещений)

Узловые Перемещения узлов по
осям X, Y, Z

Stress Tensor,
(тензор
напряжений)

Элементные Нормальные и
касательные
напряжения на
площадках,
перпендикулярных
осям X, Y, Z;
главные напряжения,
макс. касательное
напряжение;
инварианты;
эквивалентные
напряжения для разных
теорий прочности

Просмотр результатов осуществляется с помощью приложения Results (клавиша

). В этой задаче мы используем команду Create>Quick Plot. Эта команда

позволяет отобразить одновременно два вида результатов: один в виде перемещений

узлов конечно-элементной модели, а другой в виде заливки конечно-элементной модели

цветом, соответствующим значению отображаемой величины.
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Четыре клавиши в верхней части окна приложения Results для команды

Create>Quick Plot открывают разные окна этого приложения.

Окно с нажатой клавишей  (Select Result), (рис. 2.1.22) служит для выбора

результатов для отображения. В поле Select Result Cases нужно выбрать результат расчета.

В поле Select Fringe Result нужно выбрать вид результата для отображения в виде заливки

(обычно это напряжения, деформации или другие скалярные данные). Если здесь выбрать

тензор напряжений, то ниже этого поля появится опция Quantity, с помощью которой

можно выбрать отображаемый компонент тензора напряжений. Если выбрать другой

тензорный или векторный результат, то эта опция позволит выбрать один из компонентов

этого вектора или тензора для отображения в виде заливки. В поле Select Deformation

Result нужно выбрать результат для отображения в виде перемещений узлов (обычно это

перемещения или другие векторные данные). После нажатия клавиши Apply в

графическом окне появится деформированная конечно-элементная модель, покрытая

заливкой
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Рис. 2.1.22. Окно команды Create>Quick Plot при нажатой клавише Select Results

Клавиша  (Fringe Attributes) открывает окно настройки заливки (рис. 2.1.23).

Здесь пользуясь опциями Spectrum и Range можно изменить палитру заливки, пользуясь

опциями Style и Shading стиль заливки, вывести на экран название результата и его

максимальное и минимальное значение (Show MaxMin label)и др.
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Рис. 2.1.23. Окно команды Create>Quick Plot при нажатой клавише Fringe

Attributes

Клавиша  (Deform Attributes) открывает окно настройки отображения

деформации модели (рис. 2.1.24). В этом окне можно выбрать цвет и толщину линий

отображения деформированного и недеформированного состояния модели, применить

способ отображения деформированной модели:

 прозрачной сеткой (Wireframe);

 с удалением невидимых линий (Hidden Line);

 с заливкой граней элементов и с затенением (Shaded).
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Рис. 2.1.24. Окно команды Create>Quick Plot при нажатой клавише Deform

Attributes

Задать масштаб деформаций модели можно в поле Scale Factor. Интерпретация

этого масштаба зависит от опции Scale Interpretation. Если включена опция Modal Scale,

то величина, введенная в поле Scale Factor, будет интерпретироваться как величина

максимальной деформации в процентах от характерного размера модели. Значение

масштаба 1 в этом случае означает, что максимальное перемещение будет равно

максимальному размеру модели. Если включена опция True Scale, то величина, введенная

в пункте Scale Factor, действительно является масштабом деформаций.

Попробуйте разные способы отображения результатов.

Клавиша  (Animation Attributes) открывает окно настройки отображения

деформаций способом анимации (рис. 2.1.25). Попробуйте самостоятельно разобраться,

как получить изображение деформаций в движении и настроить изображение.
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Рис. 2.1.25. Окно команды Create>Quick Plot при нажатой клавише (Animation

Attributes)

Примеры отображения результатов приведены на рис. 2.1.26 и на рис. 2.1.27.

Рис. 2.1.26. Деформированное состояние конструкции
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Рис. 2.1.27. Эквивалентные напряжения по Мизесу (4-я теория прочности) в

верхнем слое оболочечных элементов

Чтобы получить представление о работе конструкции, обязательно выведите на

экран и рассмотрите следующие основные результаты расчетов (табл. 2.1.2):

 Деформации конструкции. Особое внимание обратите на максимальный прогиб,

значение которого выводится в левом нижнем углу экрана при отображении

деформаций;

 Эквивалентные напряжения по Мизесу (4 теория прочности);

 Силы в закреплениях;

 Нормальные напряжения – Stress Tensor>X Component, Stress Tensor>Y Component;

 Касательные напряжения - Stress Tensor>XY Component;

 И другие результаты по желанию.

1.1.10 Анализ результатов
Как Вы могли заметить, моделирование даже такой простой конструкции, как

пластинка, рассмотренная в данном примере, требует от инженера определения многих

величин, характеризующих материалы, геометрию конструкции, граничные условия. При

задании каждой из этих характеристик Вы могли ошибиться. Еще более остро данная

проблема встает при моделировании сложных технических объектов, таких как

летательный аппарат, где приходится отображать в модели все сколько-нибудь

значительные особенности конструкции, и при описании каждой из этих особенностей

возможна ошибка. Поэтому, получив результаты расчета, Вы ни в коем случае не должны

считать, что работа закончена, и полученный результат можно передавать Заказчику.

Полученные результаты необходимо проанализировать.
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Самым распространенным приемом, используемым для проверки моделирования,

является качественный анализ результатов. Инженер рассматривает рассчитанное

поведение конструкции и пытается его для себя объяснить. Если поведение конструкции

кажется ему правдоподобным, то он считает модель адекватной. Естественно, чтобы

использовать данный способ проверки, инженер должен быть очень опытным.

Гораздо более надежный способ проверки – рассмотреть поведение модели при

случае нагружения, для которого решение может быть предсказано аналитически (хотя бы

приблизительно). Такой случай нагружения может быть как одним из расчетных случаев

нагружения, так и специально создаваться для проверки модели.

Ошибка моделирования может проявляться и только при определенных

особенностях нагружения конструкции. Поэтому, проверив результаты для одного случая

нагружения, нельзя успокаиваться и принимать результаты для остальных случаев

нагружения на веру. Анализу должно подвергаться поведение конструкции при всех

случаях нагружения.

Существует множество приемов проверки модели, многие из которых

поддерживаются возможностями MSC.Nastran и будут рассмотрены в дальнейшем.

Проверку нашей модели можно провести, рассмотрев нашу пластинку как

консольную балку, нагруженную на конце перерезывающей силой (рис. 2.1.28).

P V

t

h

Y

l

Рис. 2.1.28. Изгиб балки

По балочной теории приближенно прогиб на конце пластинки можно оценить с

помощью следующего соотношения:

GF
lP

EJ
lPv сд





 

3

3

, (1)
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где J – момент инерции сечения (для прямоугольного сечения
12

3 tbJ 
 ); E – модуль

упругости;  
12
EG  – модуль сдвига;  – коэффициент Пуассона; сд – коэффициент

сдвига, а остальные обозначения видны на рис. 2.1.28. Для прямоугольного поперечного

сечения сд =3/2.

Сравните вычисленный Вами прогиб с полученным в расчете.

1.1.11 Контрольные вопросы
Решив задачу №1, Вы должны были получить начальное представление о

моделировании и анализе конструкций в системе MSC.Nastran. Для проверки знаний Вам

предлагается ответить на следующие вопросы:

1. Назовите основные этапы расчета конструкций в системе MSC.Nastran.

2. Назовите основные этапы создания конечно-элементной модели в препроцессоре

Patran.

3. Какие конструкции моделируются универсальным оболочечным элементом Shell?

4. Зачем нужна геометрическая модель?

5. Какие приложения программы Patran использовались при решении задачи?

6. Как посмотреть номера (идентификаторы) объектов?

7. Какие характеристики определяются для материалов?

8. Что такое свойство элементов?

9. Граничные условия, виды граничных условий;

10. Почему при приложении распределенной нагрузки в угловые узлы пластинки

прикладывались силы вдвое меньшие, чем в остальные узлы, лежащие на стороне

пластинки?

11. В каких случаях корректно использовать для расчета напряжений и деформаций

алгоритм линейной статики?

12. Что необходимо указать при запуске линейного статического расчета?

13. Какие результаты MSC.Nastran выдает для оболочечных элементов?

14. Особенности задания масштаба отображения деформаций.

15. Объясните распределение нормальных и касательных напряжений по конструкции.

16. Объясните, почему вблизи заделки напряжения повышены?

17. Как удостовериться в правильности полученных результатов конечно-элементного

расчета?
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2.2 Пример решения задачи №2 “Моделирование и статический расчет
объемных силовых элементов конструкции с использованием
MSC.Patran/MSC.Nastran”

Целью решения данной задачи является приобретение навыков моделирования

объемных тел в препроцессоре Patran с помощью объемных конечных элементов типа

Solid на примере моделирования и расчета конструкции кронштейна. Будет уделено

внимание возможностям визуализации модели и результатов.

1.2.1 Объемный элемент типа Solid
Библиотека конечных элементов MSC.Nastran содержит шесть видов объемных

конечных элементов:

 линейный тетраэдальный элемент (4 - узловой);

 линейный призматический элемент (6 - узловой);

 линейный гексагональный элемент (8 - узловой);

 параболический тетраэдальный элемент (8 - узловой);

 параболический призматический элемент (12 - узловой);

 параболический гексагональный элемент (16 - узловой).

У линейных элементов на одну кромку приходится два узла (через две точки

можно провести прямую линию), а у параболических - по три узла (через три точки можно

провести параболу). Поскольку линейные элементы содержат меньше узлов, построенные

на их основе модели содержат меньше степеней свободы и, следовательно, более

экономичны. Однако четырехузловой тетраэдр обычно завышает жесткость конструкции.

Чтобы избежать этого, нужно либо измельчать конечно-элементную сетку, либо

применять параболический тетраэдр. Опыт показывает, что второй способ более

экономичен, так как требуемая точность расчета достигается при меньшем количестве

узлов конечно-элементной сетки. Таким образом, обычно рекомендуется использовать

линейные призматические и гексагональные элементы и параболический тетраэдальный

элемент.
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Линейный   г ексаэдр Линейная   призма Линейный   тетраэдр

Параболическая   призмаПараболический   г ексаэдр Параболический   тетраэдр

Рис. 2.2.1. Объемные элементы в MSC.Nastran

1.2.2 Геометрическое моделирование объемных тел
Моделирование объемных тел в MSC.Patran осуществляется с помощью Solid-ов.

Solid-ы представляют собой объединение поверхностей, образующих замкнутый объем.

Patran рассматривает их как объемное тело и позволяет разбить это тело на объемные

конечные элементы.

Объемные конечные элементы в Patran также называются Solid-ами, но не надо

путать их с геометрическими солидами.

Создать Solid-ы в системе Patran можно многими способами, используя команды

приложения  :

 выдавливание из поверхности вдоль какого-либо вектора на заданную длину –

команда Create>Solid>Extrude;

 создание тела вращением поверхности вокруг заданной оси на заданный угол –

команда Create>Solid>Revolve;

 создание геометрических примитивов, а именно, прямоугольного параллелепипеда,

конуса, сферы и цилиндра – команда Create>Solid>Primitives;

 создание Solid-а по координатам его вершин - команда Create >Solid>Vertex.

 и др.

Solid-ы могут быть разбиты на составляющие их поверхности – команда

Edit>Solid>Disassemble, у них могут быть срезаны фаски – команда Edit>Solid>Edge

Blend, они могут быть рассечены плоскостями – команда Edit>Solid>Break.

Несколько Solid-ов могут быть объединены в один – команда Edit>Solid>Boolean,

клавиша Add .
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Из одного Solid-а можно вычесть несколько Solid-ов – команда

Edit>Solid>Boolean, клавиша Subtract .

Может быть создан Solid, являющийся пересечением двух Solid-ов – команда

Edit>Solid>Boolean, клавиша Intersect  и другие возможности.

1.2.3 Моделирование кронштейна
В данной задаче рассматривается конструкция кронштейна (рис. 2.2.2-2.2.3).

Кронштейн присоединяется к остальной конструкции четырьмя крепежными элементами,

расположенными по углам основания кронштейна и нагружается силой, приложенной к

нижней стороне отверстия проушины. Конструкция изготовлена из сплава АМГ-6 (модуль

упругости – 70000 МПа, коэффициент Пуассона – 0.3, плотность – 2700кг/м3 и предел

текучести – 160 МПа).

Варианты размеров конструкции и нагрузок приведены в табл. 2.2.1.

Рекомендуется при задании данных использовать следующую систему единиц:

силы в [Н], размеры в [мм], напряжения и давления в [МПа], а массу в [т].

L4=L2-2*R3; L5=L1-2*R3; R4=5мм

Таблица 2.2.1. Варианты размеров конструкции кронштейна и нагрузок

№ q,
 Н

/м
м

2

L 1
, м

м

L 2
, м

м

L 3
, м

м

R
1, 

м
м

R
2, 

м
м

R
3, 

м
м

S 1
, м

м

S 2
, м

м

S 3
, м

м

1 110 15 20
2 130 20 30
3 150 15 20
4 170 20 30
5

100

190 15 20
6 110 20 30
7 130 15 20
8 150 20 30
9 170 15 20
10

1.0

140

60

190

10 20 10

20 30

10

L4=L2-2*R3; L5=L1-2*R3; R4=5мм
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Рис. 2.2.2. Конструкция кронштейна

 q

Сварка  q –нагрузка, распределенная равномерно по
нижней поверхности отверстия кронштейна и
направленная вниз.

L4

L5

R4

Рис. 2.2.3. Нагрузки и закрепления для кронштейна

1.2.4 Геометрическое моделирование кронштейна
Препроцессор MSC.Patran предоставляет широкий набор приемов моделирования

объемных тел и предлагаемый здесь способ создания геометрической модели кронштейна

является одним из многих возможных способов.

Кронштейн состоит из трех плит с толщинами S1, S2 и S3 (рис. 2.2.4).

Solid-ы, соответствующие этим плитам, можно сформировать с помощью

выдавливания их из поверхностей. Затем, объединив три сформированных Solid-а в один,

получим геометрическую модель кронштейна. Таким образом, необходимо построить три

поверхности, из которых можно было бы выдавить вышеупомянутые Solid-ы. Эти

поверхности будем строить совпадающими с верхней или нижней поверхностями плит.
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Рис. 2.2.4. Поверхности для выдавливания Solid-ов

Геометрическое моделирования кронштейна начнем с активации приложения

Geometry, нажав кнопку  панели приложений.

Построим поверхность для основания кронштейна (рис. 2.2.4, поверхность 1) по

четырем угловым точкам – команда Create>Surface>Vertex. При выполнении этой

команды в полях Surface Vertex 1-4 List следует указать четыре угла поверхности, задав их

координаты в квадратных скобках. Вместо координат точек можно указать на созданные

ранее точки. В поле Surface ID List обозначен номер (идентификатор) создаваемой

поверхности.

После исполнения команды (нажать клавишу Apply) на экране появится

поверхность. Если Вы ошиблись, можно отменить команду, нажав клавишу  на панели

инструментов и, исправив данные, повторить команду, нажав клавишу Apply.

При выборе геометрических объектов удобно пользоваться панелью визуализации

идентификаторов объектов, а также панелями инструментов, позволяющими назвать тип

выбираемого объекта, например, точки – клавиша Point , узлы – клавиша Node ,

кривые – клавиша Curve , поверхности - клавиша Surface  , грани Solid-а – клавиша

Solid Face  и многих других. Эти панели инструментов появляются рядом с окнами

команд в зависимости от того, какими объектами эта команда будет оперировать.

Построим поверхность для кольцевой части проушины кронштейна (рис. 2.2.4,

поверхность 3). Для этого проведем две окружности радиусом R2, воспользовавшись,

например, командой Create>Curve>2D Circle. При выполнении этой команды в секции

Circle Radius следует ввести значение радиуса окружности, в поле Construction Plane List

следует указать вектор, перпендикулярный к плоскости, в которой будет лежать
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окружность (ссылка на ось системы координат Coord 0.1 - ось Х 0-ой (базовой) системы

координат). В поле Center Point List указать координаты точки центра окружности. Для

удобства работы можно изменить проекцию изображения геометрической модели на

экране, нажав одну из клавиш панели инструментов, управляющих ориентацией модели в

графическом окне.

Теперь создадим круглую поверхность, ограниченную окружностью радиусом R2, с

помощью команды Create>Surface>Trimmed. В списке Option этой команды следует

выбрать пункт Planar. В поле Outer Loop List следует указать окружность для внешнего

контура поверхности, а поле Inner Loop List – оставить пустым. На вопрос системы

“Удалить ли оригинальные кривые, по которым создается поверхность” можно ответить

“нет”, так как они могут понадобиться для дальнейших построений.

Построим поверхность для остальной части кронштейна (рис. 2.2.4, поверхность 2).

Сначала построим две точки для проведения линии, по которой пересекаются срединная

поверхность проушины и граница основания – точки А и В (рис. 2.2.4), используя команду

Create>Point>XYZ. Координаты точек А и В легко найти из чертежа. Затем построим и

саму линию, выполнив команду Create>Curve>Points. Точки можно выбирать мышкой

или указывать их идентификаторы. Далее построим линию, проходящую через точку А и

направленную по касательной к внешней окружности кольца – команда

Create>Curve>TanPoint. В появившемся окне следует сделать:

 отключить опцию Auto Execute;

 установить клавишу  в положение All Tangents, чтобы построить

все касательные;

 в поле Point List мышкой выбрать точку, из которой будет проведена касательная, а в

поле Curve List выбрать окружность, которой линия будет касаться.

Аналогичным способом провести касательную линию из точки В.

Если опция Trim Original Curve включена, то оригинальные кривые в месте

соприкосновения с касательной кривой будут обрезаны.

Лишние геометрические объекты, в частности кривые, можно удалить командой

Delete>Curve, указав в поле Curve List удаляемую кривую.

Теперь нужно замкнуть контур поверхности 2, проведя линию через точки С и D с

помощью команды Create>Curve>Points. Созданные кривые объединим в один контур

командой Create>Curve>Chain. При выполнении этой команды в поле Curve List следует

указать все кривые, образующие границу будущей поверхности 2. В опции Option нужно
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выбрать Planar. При выборе кривых мышкой, кроме первой в списке, нужно держать на

клавиатуре нажатой кнопку SCHIFT.

Наконец создадим поверхность 2 командой Create>Surface>Trimmed. На этот раз

следует указать только одну кривую контура границы поверхности 2.

Создадим объемные тела, используя команду выдавливания из поверхностей –

Create>Solid>Extrude. В поле Translation Vector нужно указать вектор, вдоль которого и

на длину которого будет выполняться выдавливание. В поле Surface List нужно указать

поверхность, которая будет выдавливаться. Таким образом, выдавите объемные тела из

всех трех поверхностей на соответствующие толщины. Объемные тела стенки и

проушины кронштейна необходимо сместить к срединной поверхности. Это можно

сделать командой Transform>Solid>Translate. При выполнении этой команды требуется

в поле Translation Vector указать вектор, на который будет смещено объемное тело, а в

поле Solid List указать перемещаемое тело. Включить опцию Delete Original Solid, чтобы

был удален исходный Solid.

При выполнении многих операций для получения изображения модели на экране,

соответствующего последней выполненной команде нужно изображение перерисовывать,

пользуясь клавишей  или  панели инструментов.

Все ненужные геометрические объекты, появившиеся при моделировании,

целесообразно удалить командой Delete, выбрав нужные объекты для удаления.

Теперь объединим три объемных тела в одно командой Edit>Solid>Boolean

(рис. 2.2.5).

Рис. 2.2.5. Окно команды Edit >Solid>Boolean
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В поле команды следует нажать клавишу объединения Add  и указать в поле

Solid List список тел для объединения. В списке для объединения нужно указывать по два

объекта. В результате должен получиться для всего кронштейна один Solid, который весь

целиком меняет цвет при подведении к нему курсора.

Углы основания нашего кронштейна должны быть скруглены. Это можно сделать

командой Edit>Solid>Edge Blend (рис. 2.2.6).

Рис.2.2.6. Окно команды Edit >Solid>Edge Blend

При выполнении этой команды следует выбрать опцию, соответствующую

округлению граней (клавиша Constant Radius ), и опцию скругления одной кромки

(клавиша Edge(s) of Solid ). В поле Constant Radius введите значение радиуса

скругления. В поле Solid Edge List укажите грани для скругления. При подведении мышки

к конкретной грани появляется список прилегающих кромок прилегающих граней Solid-а

(рис. 2.2.7).
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Рис. 2.2.7. Вид списка кромок Solid-а

Если указать на одну из позиций в списке, на изображении Solid-а загорается

соответствующая кромка. Перебирая, таким образом, список, можно выбрать нужные

кромки для скругления.

Теперь сделаем отверстия для проушины кронштейна и болтов. Создадим сначала

цилиндрическое тело с радиусом отверстия проушины, ось которого совпадает с осью

отверстия. Высота цилиндра должна превышать толщину проушины и цилиндр должен

располагаться так, чтобы выглядывать с обеих сторон проушины. Это можно сделать

аналогично созданию цилиндрического тела из поверхности 3. Затем “пробъем” отверстие

в проушине с помощью команды вычитания объемных тел Edit>Solid>Boolean. Для этого

следует нажать клавишу объединения  (Subtract), выбрать в поле Target Solid тело,

из которого будет производиться вычитание, а в поле Subtracting Solid выбрать тело,

которое будет вычитаться.

Аналогичным образом сделайте отверстия под болты. Для создания цилиндра

пробивки отверстия под болты используйте для разнообразия команду

Create>Solid>Primitive (рис. 2.2.8). Теперь нужно передвинуть созданные примитивы,

совместив их оси поочередно с осями отверстий под болты командой

Transform>Solid>Translate, и сделать вычитание Solid-ов кронштейна и

цилиндрического примитива, создав отверстия под болты.
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Рис. 2.2.8. Окно команды Create> Solid> Primitive

Для удобства приложения нагрузки на кронштейн целесообразно, чтобы узлы на

поверхности отверстия проушины, в которые должна прикладываться нагрузка, лежали на

одной поверхности, а узлы, в которые нагрузка прикладываться не должна, – на другой.

Для создания поверхности отверстия проушины, на которую будет прикладываться

нагрузка, нужно сделать следующее:

 создать цилиндр внутри отверстия;

 разбить его в горизонтальной плоскости командой Edit>Solid>Break. При

выполнении этой команды выберите опцию Plane (разбивать плоскостью), в поле

Solid List укажите цилиндр, а в поле Break Plane List укажите плоскость, которая

будет проходить через центр отверстия и перпендикулярно которой будет

приложена нагрузка;

 с помощью команды Edit>Solid>Imprint (сделать отпечаток одного тела на

другом) разбейте внутреннюю поверхность отверстия проушины. При выполнении

этой команды следует в поле Imprinting Solid указать половину цилиндра, а поле

Imprinted Solid указать тело кронштейна.
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Геометрическая модель одного из вариантов кронштейна показана на рис. 2.2.9.

Рис. 2.2.9. Геометрическая модель кронштейна

1.2.5 Задание материалов и свойств
В этой задаче для материала кроме модуля упругости (Elastic Modulus) и

коэффициента Пуассона (Poisson’s Ratio) требуется также задать и плотность (Mass

Density).

Для создания материала войдем в приложение  и вызовем окно команды

Create>Isotropic>Manual Input. Здесь в поле Material Name задайте имя материала.

Нажатием клавиши Input Properties вызовите окно ввода свойств материала и задайте там

значение модуля упругости, коэффициента Пуассона и плотности. В опции Constitutive

Model нужно выбрать Linear Elastic (линейный упругий материал). Не забудьте выполнить

команду, нажав клавишу Apply.

Модифицировать созданный ранее материал можно командой Modify>Isotropic.

Для создания свойства объемных конечных элементов надо перейти в приложение

 и вызвать команду Create>3D>Solid. При выполнении этой команды следует

задать имя свойства в поле Property Set Name и, нажав клавишу Input Properties, выбрать

материал в поле Material Name. Кроме того, в разделе Application Region в поле Select

Members нужно выбрать мышкой тело (Solid) кронштейна.

Модифицировать ранее созданное свойство можно с помощью команды

Modify>3D>Solid.
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1.2.6 Разбиение Solid-а на конечные элементы

Для создания конечных элементов на Solid-е нужно перейти в приложение 

и вызвать команду Create>Mesh>Solid. В поле Element Shape выберите тетраэдальную

форму элемента (Tet). Алгоритм разбиения в поле Mesher выберите TetMesh. Топологию

элемента в поле Topology выберите Tet10. Затем в поле Input List нужно выбрать

разбиваемое на элементы объемное тело кронштейна, отключить опцию Automatic

Calculation (автоматическое вычисление размера элемента) и задать размер элемента в

поле Value. В качестве размера элемента можно принять минимальную толщину

кронштейна.

Теперь все готово для создания конечно-элементной сетки кронштейна. Перед

выполнением команды создания конечно-элементной сетки во избежание потери

информации рекомендуется сохранить модель.

Примерный вид конечно-элементной сетки кронштейна показан на рис. 2.2.10.

Рис. 2.2.10. Конечно-элементная модель варианта кронштейна

1.2.7 Создание закреплений и нагрузок
Кронштейн присоединяется к остальной части конструкции четырьмя крепежными

элементами, расположенными по углам основания. Данное условие опирания

приблизительно можно моделировать закреплением поступательных степеней свободы

узлов, лежащих на контурах отверстий под крепеж.

Для задания такого закрепления нужно перейти в приложение 

(Граничные условия) и вызвать окно команды Create>Displacement>Nodal. В окне этой

команды в поле New Set Name введите имя закрепления. Вызовите клавишей Input Data
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окно, в котором в поле Translations задайте нулевые перемещения по всем

поступательным степеням свободы, (рис. 2.2.11). Выполните команду, нажав клавишу

ОК.

Рис. 2.2.11. Окно задания перемещений

Вернувшись в окно Loads/BCs, нажмите клавишу Select Application Region. В

появившемся окне (рис. 2.2.12), установив курсор в поле Select Geometry Entities, нужно

поочередно мышкой выбирать объекты для закрепления и, действуя клавишами Add и

Remove, сформировать список объектов, к которым прикладываются закрепления. Этот

список будет отображен в поле Application Region. В нашем случае следует выбрать

опцию Geometry (тогда будут выбираться для закрепления геометрические объекты) и

указать кривые по периметрам отверстий под болты на обеих сторонах кронштейна.

Выбирать кривые удобно нажав клавишу  панели выбора объектов, последовательно

указывая нужную кривую и добавляя ее в список закрепляемых кривых нажатием

клавиши Add.

Не забывайте исполнять команды, нажимая соответствующие клавиши OK и

Apply.
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Рис. 2.2.12. Окно выбора объектов для задания закреплений

Распределенная нагрузка должна быть приложена на грани элементов, которые

лежат на нижней поверхности отверстия кронштейна, которую мы специально создавали.

Распределенная нагрузка прикладывается к нижней половине поверхности

отверстия проушины с помощью команды Create>Total Load>Element Uniform. При

выполнении этой команды следует в поле New Set Name ввести имя нагрузки. Нажатием

клавиши Input Data вызвать окно, в котором в поле Load нужно задать суммарный вектор

нагрузки. Нажатием клавиши Select Application Region выберите поверхность, к которой

прикладывается нагрузка. В нашем случае следует выбрать поверхность,

соответствующую нижней половине поверхности отверстия проушины.

Выполните команду, нажав клавишу Apply. На экране должно появиться

изображение приложенных нагрузок.

1.2.8 Запуск на расчет

Запуск на расчет выполняется в приложении  (Анализ) командой

Analyze>Entire Modal>Full Run.

Тип анализа выбирается с помощью клавиши Solution type.

При решении этой задачи мы считаем, что в материале нет пластических

деформаций и перемещения точек конструкции малы и существенно не изменяют

геометрию конструкции. Нагрузка не меняется во времени. Такой ситуации соответствует

тип анализа Linear Static (линейная статика).



48

Клавиша Subcases позволяет настроить расчетный случай (выбор случая

нагружения, набора выдаваемых результатов и др.), а клавиша Select Subcases позволяет

выбрать расчетный случай (случаи) для расчета. Для случая нагружения Default

расчетный случай настраивается и выбирается по умолчанию. Остальные клавиши дают

доступ к различным опциям, в которых здесь нет необходимости разбираться, поскольку

их значения по умолчанию подходят в нашем случае.

После нажатия клавиши Apply происходит следующее:

 Patran генерирует файл задания на расчет для системы конечно-элементного анализа

MSC.Nastran;

 запускается система MSC.Nastran, которая выполняет расчет в соответствии с

заданием на расчет. В результате расчета создается файл (в нашем случае с

расширением .xdb), который содержит результаты расчета.

1.2.9 Просмотр результатов
Для того чтобы просмотреть результаты в системе Patran нужно присоединить

файл результатов, полученных системой MSC.Nastran, к базе данных Patran-а. Это можно

сделать следующим образом:

 Вызвать окно приложения ;

 Установить команду Access Result>Attach XDB>Result Entities;

 Нажать клавишу Select Result File и в появившемся окне указать файл с

результатами (*.xdb);

 Выполнить команду, нажав клавишу Apply.

Визуализируем деформации и напряжения кронштейна, полученные в конечно-

элементном расчете.

Просмотр результатов осуществляется с помощью приложения , где

содержатся разнообразные возможности обработки результатов. Для отображения

деформаций кронштейна в этой работе используем команду Create>Deformation

(рис. 2.2.13), которая позволяет отобразить деформации конструкции в виде перемещений

узлов конечно-элементной модели и команду Create>Fringe (рис. 2.2.14), которая

отобразит деформации и напряжения в виде заливки цветом, соответствующим значению

отображаемой величины.

Окна команды содержат клавиши:
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  (Select Results) – выбор случая нагружения и типа результатов для

отображения;

  (Target Entities) - выбор объектов, для которых визуализируются результаты;

  (Display Attributes) – настройки видов отображения;

  (Plot Options) – некоторые дополнительные возможности по обработке

результатов расчетов;

  (Animation Option) – настройки параметров анимации.

Нажатие клавиши  вызывает окно (рис. 2.2.13), в котором в поле Select Results

Case(s) находится список случаев нагружения, имеющихся в базе данных задачи. Выберем

мышкой нужный расчет, если их несколько.

В поле Select Deformation Result находится список доступных видов результатов.

Для отображения деформаций кронштейна выберем (отметив мышкой) вид Displacement

Translational (перемещения).

В поле Show As можно выбрать Resultant (полный вектор деформаций) или

Component (компоненты вектора).

Выполнить команду, нажав клавишу Apply
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Рис. 2.2.13. Окно команды Create>Deformation при нажатой клавише  (Select

Results)

Есть возможность отображать результаты только для части модели. Для этого

нажатием клавиши  вызовем окно (рис. 2.2.14), в котором в поле Target Entity можно

выбрать в качестве объектов для отображения:

 Current Viewport - объекты, расположенные в текущем виде на экране;

 Nodes - узлы модели;

 Elements - элементы модели;

 Groups - группы;

 и др.

Выберем для отображения деформаций кронштейна опцию Current Viewport.

Apply.
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Рис. 2.2.14. Окно команды Create>Deformation при нажатой клавише  (Target

Entities)

Нажатием клавиши  вызовем окно, которое содержит настройки отображения

деформации модели (рис. 2.2.15). В этом окне можно выбрать цвет и толщину линий

отображения деформированного и недеформированного состояния модели, применить

способы отображения деформированной модели:

 прозрачной сеткой (Wireframe);

 с удалением невидимых линий (Hidden Line);

 с заливкой граней элементов и тенями (Shaded).

Задать масштаб деформаций модели можно в поле Scale Factor. Напомним, что

интерпретация этого масштаба зависит от опции Scale Interpretation.
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Рис. 2.2.15. Окно команды Create>Deformation при нажатой клавише   (Plot

Options).

Один из вариантов изображения деформаций кронштейна командой

Create>Deformation показан на рис. 2.2.16.
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Рис. 2.2.16. Деформированное и исходное (недеформированное) состояние

кронштейна

Теперь нарисуем деформации кронштейна командой Create>Fringe (рис. 2.2.17).

Рис. 2.2.17. Окно команды Create>Fringe
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Оперируя клавишами , можно нарисовать деформации и

напряжения в кронштейне способом заливки. Клавиша  в этой команде открывает

окно настройки заливки, в котором можно изменить палитру заливки, тип заливки (с

постоянными цветовыми областями на элементе, с непрерывным изменением цвета и др.).

Примеры таких изображений приведены на рис. 2.2.18- 3.2.21.

Рис. 2.2.18. Деформированное состояние кронштейна заливкой (Style –

Discrete/Smooth)

Рис. 2.2.19. Деформированное состояние кронштейна заливкой (Style – Continuous)



55

Рис. 2.2.20. Нормальные напряжения, действующие вдоль оси Z (Style –

Discrete/Smooth). Видны концентрации растягивающих и сжимающих напряжений

в опорной плите и отверстиях под болты

Рис. 2.2.21. Нормальные напряжения, действующие вдоль оси Z (Style –

Continuous). Видны концентрации растягивающих и сжимающих напряжений в

опорной плите и отверстиях под болты

Отобразите деформации конструкции и напряжения (нормальные, касательные,

эквивалентные по Мизесу).

Список основных результатов, вычисляемых MSC.Nastran для объемных

элементов, приведен на рис. 2.2.22. Этот список для выбора нужного типа результата

появляется в окне приложения Results при нажатой клавише , если в поле Fringe Result

пометить строчку Stress Tensor и открыть выпадающее меню Quantity. Названия типов

результатов, в основном, легко переводятся на русский язык.
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Рис. 2.2.22. Список типов напряжений для объемного элемента Solid.

1.2.10 Анализ результатов
Проверим правдоподобность полученных результатов. Проверка в данном случае

может проводиться на основе вычисления максимальных значений напряжений в каком-

либо сечении проушины по балочной теории (рис. 2.2.23).

Сечение для проверки может быть выбрано любое, лишь бы оно не пересекало

основания кронштейна или кольцо проушины. Это ограничение связано с тем, что в

основании кронштейна и в кольце проушины характер напряжений в принципе не

подчиняется балочной теории из-за близости нагрузок или закреплений.

В сечении проушины максимальное значение нормальных напряжений на

площадке, параллельной основанию, определяется изгибающим моментом и согласно

балочной теории равно:

maxmax y
J
M


,

где max – максимальное значение нормальных напряжений в сечении;

М – изгибающий момент;

J – момент инерции сечения;

ymax – координата наиболее удаленной от центра тяжести сечения точки.



57

 q

 σmax

 -σmax

 σ

 y
m

ax

Сечение проушины
кронштейна

Рис. 2.2.23. Нормальные напряжения в сечении проушины согласно балочной

теории

Сравните в выбранном сечении максимальные значения напряжений, вычисленные

по балочной теории и методом конечных элементов. Эти напряжения могут отличаться

из-за того, что исследуемый объект не является балкой. Длина конструкции соизмерима с

габаритами поперечного сечения, а само поперечное сечение изменяется по длине

проушины. Тем не менее, это отличие не должно превышать 30 - 40%.

Посмотреть напряжения в сечении, полученные в конечно-элементном расчете,

можно построив график напряжений вдоль верхнего края стенки кронштейна. Это можно

сделать в приложении Result с помощью команды Create>Graph>Y vs X0 следующим

образом:

 в поле Select Result Case выберите нужный расчет;

 в поле Select Y Result выберите напряжения, действующие по направлению длины

кронштейна;

 в списке X выберите позицию Coordinate;

 в поле Select Coordinate Axis задайте ось координат, направленную вдоль длины

кронштейна;

 нажмите клавишу  (Target Entities), в верхней части окна и в списке Target

Entity выберите позицию Nodes, а в поле Select Nodes  укажите узлы вдоль верхней

кромки стенки кронштейна.

В результате на экране появится окно с графиком, с которого можно будет снять

напряжения для нужного Вам сечения кронштейна по координате этого сечения.

Для того чтобы оценить несущую способность кронштейна посмотрите, не

превышает ли максимальное эквивалентное напряжение по Мизесу (4 теория прочности)

предела текучести материала. Выведите на экран эти напряжения в виде заливки. В этом

окне, если отмечена опция Show MaxMin Label, появятся максимальное и минимальное
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значения отображаемых напряжений. Сравните эти значения с допустимыми

напряжениями и определите коэффициент запаса прочности.

1.2.11 Контрольные вопросы
При решении данной задачи изучались объемный элемент Solid, моделирование

объемных тел средствами препроцессора Patran и некоторые возможности визуализации

модели и анализа результатов расчета. После решения этой задачи Вы должны знать

ответы на следующие вопросы:

1. Объемный конечный элемент в MSC.Nastran.

2. Для моделирования каких конструкций применяется объемный конечный элемент?

3. Какие данные содержат свойства объемного элемента?

4. Что такое геометрический Solid?

5. Какими способами можно создать Solid?

6. Какие основные операции существуют в Patran для работы с Solid-ами?

7. Какую информацию запрашивает Patran при выдавливании Solid-а?

8. Как создать скругление грани Solid –а?

9. Как создать отверстия для болтов?

10. Как разбить Solid на конечные элементы?

11. Как задать распределенную нагрузку на поверхности?

12. Как отобразить деформации модели?

13. Как отобразить напряжения модели?

14. Объясните распределение напряжений и деформаций в конструкции, положение

концентраторов напряжений.

15. Как проводилась проверка правильности модели?

2.3 Пример решения задачи №3 “Моделирование ферменных и рамных
силовых элементов конструкции с использованием
MSC.Patran/MSC.Nastran и расчет критической силы потери
устойчивости”

Целью решения данной задачи является моделирование ферменных и рамных

конструкций с использованием балочных конечных элементов Beam и элементов

сосредоточенной массы Mass, выполнение расчетов формы и критической силы потери

устойчивости в линейной постановке.

2.3.1 Балочный элемент в MSC.Nastran
Балочный элемент может воспринимать растягивающие/сжимающие усилия, сдвиг,

изгиб, кручение, и предназначен для моделирования рамных и ферменных конструкций.
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Из семейства балочных элементов библиотеки конечных элементов MSC.Nastran

наиболее универсальным является элемент Beam. Данный элемент связан с двумя узлами.

Жесткости балочного элемента при различных видах нагружения определяются

характеристиками поперечного сечения.

Местная система координат балочного элемента строится следующим образом. Ось

X направлена от первого узла элемента ко второму. Оси Y и Z перпендикулярны оси X.

Положение осей Y и Z определяет ориентацию поперечного сечения элемента и не

определяется топологией элемента.

Характеристики балочного элемента задаются в приложении  командой

Create>1D>Beam.

В окне команды (рис. 2.3.1) в поле Property Set Name задается имя свойства или это

имя выбирается из списка в поле Existing Property Sets.

Тип балочного элемента производится с помощью опции Option(s), которая

предоставляет следующие возможности:

 General Section – элемент MSC.Nastran CBAR - простой балочный элемент;

 Curved w/General Section и Curved w/Pipe Section – элемент MSC.Nastran Cbend -

балка с искривленной осью;

 Lumped Section – элемент MSC.Nastran CBEAM/PBCOMP - балка

сосредоточенными площадями (для моделирования пучков волокон

композиционных материалов);

 Tapered Section – элемент MSC.Nastran CBEAM - балка с переменным сечением

(разные сечения для начала и конца балки);

 General Section (CBEAM) – элемент MSC.Nastran CBEAM, но с одинаковыми

сечениями на концах.

Если выбрать в выпадающем меню опции Option(s) нужный пункт и нажать

клавишу Input Properties появится окно, в котором нужно будет задать параметры для

выбранного балочного элемента.

Например, если выбрать пункт General Section (CBEAM) при нажатии клавиши

Input Properties появится окно (рис. 2.3.2).
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Рис. 2.3.1. Окно команды Create>1D>Beam задания свойств конечного элемента

типа Beam
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Рис. 2.3.2. Окно ввода параметров для  выбранного поперечного сечения балочного

элемента

В этом окне в столбце Value, передвигая вниз движок, находящийся слева, можно

задать все необходимые характеристики сечения вручную.

В большинстве случаев достаточно определить значения следующих

характеристик:

 площадь поперечного сечения, А – позиция Cross Sect. Area;

 моменты инерции поперечного сечения, Iz, Iy и Izy – позиции Inertias;

 момент инерции на кручение, J –  позиция Torsional Constant;

Здесь же можно задать координаты точек поперечного сечения, для которых будут

вычисляться нормальные напряжения. Эти точки называются C, D, E и F и для них

задаются координаты Y и Z в местной системе координат элемента (поля Ys of C points, Zs

of C points, и т.д.). Эти точки обычно выбираются в местах поперечного сечения балки

наиболее удаленных от центра тяжести сечения, для того чтобы в результате расчета

получить максимальные и минимальные значения напряжений в сечении (нормальные

напряжения от изгиба в крайних точках сечения максимальны). Положение местной

системы координат элемента описано в следующем разделе.

Характеристики поперечного сечения необязательно вычислять и вводить

вручную. В этом же окне нажатие клавиши Create Sections/Beam Library вызовет окно

Beam Library (рис. 2.3.3) со списком форм поперечных сечений, для которых можно

вычислить все необходимые характеристики автоматически.
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Задав имя поперечного сечения, его форму, размеры и нажав клавишу

Calculate/Display можно визуализировать сечение на экране (рис. 2.3.4). Нажатие клавиши

Apply или OК сохранит поперечное сечение в базе данных.

Затем в окне задания свойств следует выбрать это или какое-нибудь другое

поперечное сечение в поле Section Name. В результате все поля геометрических

характеристик сечения балки заполнятся автоматически.

Определив форму и характеристики поперечного сечения и используя клавишу

Application Region окна (рис 2.3.1) можно задать, каким силовым элементам это свойство

будет принадлежать.

Рис. 2.3.3. Окно задания формы поперечных сечений элемента Beam
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Рис. 2.3.4. Визуализация сечения на экране

2.3.2 Ориентация балочного элемента
Ось X системы координат балочного элемента направлена от первого узла элемента

ко второму. Оси Y и Z перпендикулярны оси X. Поперечное сечение строится в плоскости

YZ (ось Y на рис. 2.3.4 обозначена цифрой 2, а ось Z цифрой 1).

Начальный и конечный узлы балочного элемента неоднозначно задают положение

балки в пространстве, а именно неясно как ориентированы оси Y и Z системы координат

балочного элемента относительно глобальной системы координат, в которой

моделируется конструкция. То есть поперечное сечение балочного элемента может как бы

вращаться вокруг продольной оси балки. Для однозначного определения балочного

элемента в пространстве, кроме начального и конечного узлов, задают ориентацию оси Y

местной системы координат балочного элемента относительно глобальной системы

координат.

Ориентация балочного элемента задается в окне (рис. 2.3.2) в позиции Bar

Orientation двумя способами:

1. узлом, который вместе с двумя узлами элемента задает плоскость XY местной

системы координат элемента (в столбце Value Type выпадающий список установлен

в положение Node ID);

2. вектором, параллельным плоскости XY местной системы координат балочного

элемента (в столбце Value Type выпадающий список установлен в положение

Vector).

В данной задаче будут рассматриваться силовые элементы с осесимметричным

поперечным сечением. Очевидно, что в случае осесимметричного сечения задание

ориентации может быть любым, без какого бы то ни было влияния на результат.

Единственное ограничение заключается в том, что не допускается совпадение оси Y
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элементной системы координат с продольной осью элемента (она же ось X элементной

системы координат).

2.3.3 Элемент сосредоточенной массы Mass
Элемент сосредоточенной массы Mass является одним из средств моделирования

инерционных характеристик конструкции в динамических расчетах и используется для

моделирования частей конструкции, обладающих массой, но не имеющих жесткости (не

участвующих в силовой работе конструкции).. Элемент Mass помимо своего основного

назначения может быть использован и в статических расчетах, например для

моделирования силы веса конструкции.

Топологически элемент Mass представляет собой точку, связанную с одним узлом,

где находится сосредоточенная масса. При задании свойства для этого элемента могут

быть заданы следующие инерционные характеристики:

 массы моделируемого объекта по разным направлениям;

 моменты инерции моделируемого объекта;

 смещения центра масс объекта от узла вдоль осей глобальной системы координат;

 др.

Характеристики элемента Mass задаются в приложении  командой

Create>0D>Mass.

В окне команды (рис. 2.3.5) в поле Property Set Name задается имя свойства или

имя выбирается из списка в поле Existing Property Sets.

Далее в выпадающем списке Option(s) следует выбрать тип элемента Lumped

(сосредоточенная масса). Затем следует нажать клавишу Input Properties и в  появившемся

окне задать характеристики элемента Mass (рис. 2.3.6). В поле Select Members опции

Application Region задается объект (точка, узел), к которому присоединяется масса.
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Рис. 2.3.5. Окно создания свойства элемента Mass

Рис. 2.3.6. Окно ввода данных при создании свойства элемента Mass



66

2.3.4 Природа потери устойчивости в упругих системах
Расчет конструкции на устойчивость ферменной конструкции будет выполняться в

линейной постановке (устойчивость по Эйлеру). В ходе этого расчета перемещения

предполагаются малыми.

Не будет лишним сказать несколько слов о природе потери устойчивости.

Рассмотрим конструкцию, статически нагруженную таким образом, что потеря

устойчивости еще не наступила. Естественно, что конструкция будет деформироваться

так, чтобы уравновесить внешнюю нагрузку упругими силами и будет оставаться в этом

положении равновесия, пока не изменится нагрузка. Если сообщить этой конструкции

малое отклонение от положения равновесия, то наряду с уже действующими силами в

конструкции возникнут два дополнительных фактора.

1. Упругие силы, стремящиеся вернуть конструкцию в положение равновесия

(Первая система сил).

2. Система сил, обусловленная изменением геометрии конструкции (Вторая система

сил). Природа этой системы сил следующая. Рассматриваемое малое отклонение

вызывает изменение геометрии конструкции. Нагрузка на конструкцию с

измененной геометрией действует иначе, чем на конструкцию в ее начальном

состоянии. В связи с этим нагрузку удобно делить на две составляющие. Первая

составляющая – это часть нагрузки, действие которой на конструкцию с

изменением геометрии конструкции осталось неизменным. Вторая составляющая –

часть нагрузки, действие которой на конструкцию при искажении геометрии

изменилось (рис. 2.3.7). Вторая составляющая нагрузки мала по сравнению с

первой ввиду малости изменений конструкции. Вторую составляющую нагрузки

будем называть второй системой сил.

Насчет первой системы сил все ясно – эти силы стремятся вернуть конструкцию в

положение равновесия. Величина этих сил прямо пропорционально зависит от величины

отклонения от положения равновесия и не зависит от величины внешней нагрузки.

Со второй системой сил дело обстоит иначе. Эта система сил часто может

стремиться вывести конструкцию из положения равновесия и увеличить породившее ее

изменение геометрии конструкции. И что самое главное, величина этих сил прямо

пропорционально (в случае малых отклонений) зависит не только от величины

отклонения, но и от величины внешней нагрузки. Зависимость этих сил от нагрузки

обусловлена тем, что вторая система сил есть не что иное, как часть внешней нагрузки и

будет расти вместе с ней. Таким образом, при малых значениях нагрузки действие второй

системы сил будет меньше чем первой, и конструкция вернется в положение равновесия.



67

При больших нагрузках может получиться так, что действие второй системы сил начнет

преобладать над действием первой и конструкция уже не сможет вернуться к положению

равновесия. Это и будет потерей устойчивости.

Классический пример потери устойчивости – потеря устойчивости сжатой балки -

приведен на рис. 2.3.7.

P = Рос

Балка с неизмененной
геометрией: сила Р –сила
осевого сжатия

 Отклонение от
положения
равновесия

Балка с измененной геометрией:
сила Р раскладывается на две составляющие
– силу осевого сжатия Рос и перерезывающую
силу Рперер.
В данном примере Рперер является силой,
обусловленной изменением геометрии
конструкции. Отметим также, что в данном
конкретном случае Рперер стремится
увеличить изгиб балки, препятствуя
возвращению конструкции в положение
равновесия.

P Pперер

Pос

Рис. 2.3.7. Потеря устойчивости балки, нагруженной сжимающей осевой силой

Результатом расчета потери устойчивости конструкции по Эйлеру является

коэффициент критической нагрузки и форма потери устойчивости.

Физический смысл коэффициента критической нагрузки заключается в том, что,

перемножив приложенные к конструкции силы на этот коэффициент, мы получим

критическую нагрузку – нагрузку, при превышении которой силы, отклоняющие

конструкцию от положения равновесия, превышают силы, возвращающие конструкцию в

положение равновесия.

Форма потери устойчивости – характер малых отклонений конструкции от

положения равновесия, которые соответствуют критической нагрузке. Поскольку анализ

устойчивости – разновидность задачи нахождения собственных значений (вспоминаем

линейную алгебру), то форма потери устойчивости находится с точностью до множителя.

Перемещения потерявшей устойчивость конструкции, по крайней мере, в первый момент,

будут складываться из перемещений, найденных из статического расчета, и перемещений

из формы потери устойчивости, перемноженных на какой-то множитель.
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2.3.5 Описание конструкции
В данной задаче требуется рассчитать ферменную конструкцию. Ферма имеет

вершину и основание в виде четырехугольника. Длина стороны вершины ав, длина

стороны основания ан. Высота фермы h. Предлагается несколько вариантов конструкции

(рис. 2.3.8).
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Рис. 3.2.8. Варианты ферменной конструкции

Конструкция сварена из стальных труб (рис. 2.3.9). В каждой из четырех верхних

угловых точек конструкции крепится оборудование массой М. Значения характеристик

конструкции для различных  вариантов содержатся в табл. 2.3.1.
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 D

 d

Характеристики материала:

E = 210000 МПа

 = 0.3

 = 7800 кг/м3

δ

Рис. 2.3.9. Поперечное сечение стержней ферменной конструкции

Таблица 2.3.1. Варианты заданий
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1 1
2 2
3 3
4 4
5 5
6 6

40

7 1
8 2
9 3
10 4
11 5
12 6

30

1000 100 8 4 6

Рекомендуется использовать следующую систему единиц: силы в [Н], размеры в

[мм], напряжения и давления в [МПа], а массу в [т].

2.3.6 Нагрузки и закрепления
Эксплуатационная нагрузка на рассматриваемую конструкцию состоит из трех

составляющих:

 вес оборудования (груза), закрепленного на верхней части конструкции в четырех
углах (4 * М кг);

 вес конструкции (суммарная масса всех стержней фермы);
 ветровая нагрузка.

Массу оборудования предлагается моделировать в виде сосредоточенных масс в

четырех верхних углах фермы. Сосредоточенные массы моделировать элементами типа

Mass.
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Масса конструкции может быть задана в виде плотности материала (подробнее об

этом ниже).

Для упрощения моделирования силы давления ветра принимаются следующие

допущения:

1. Сила давления ветра направлена горизонтально вдоль одной из сторон

прямоугольного основания фермы;

2. Разные стержни фермы наклонены под разными углами к направлению ветра.

Вследствие чего площадь миделя и угол атаки для разных стержней будут разными,

а, следовательно, разными будут и погонные силы для разных стержней. Для

упрощения примем погонную силу для всех стержней равной погонной силе,

которая действовала бы, если бы стержни были расположены перпендикулярно

направлению ветра. В таком случае погонная сила, действующая на единицу длины

стержня, будет вычисляться по формуле

LSqCLF x //  ,

где F – суммарная сила давления ветра на стержень фермы;

L – длина стержня;

Cx – коэффициент лобового сопротивления для цилиндрической поверхности;

2

2vq 

  – скоростной напор;

LDS   - площадь миделя стержня;

 =1.29 кг/м3 - плотность воздуха;

v – скорость ветра.

Скорость ветра примем равной 40 м/с, коэффициент лобового сопротивления Cx,

равным 0.8.

Ферма крепится к жесткому фундаменту за четыре угловые точки основания

фермы. Причем, в этих четырех узлах крепления фермы не допускаются ни

поступательные перемещения угловых точек основания, ни вращательные перемещения

этих точек.

2.3.7 План решения задачи
1. Выполнить линейный статический расчет конструкции. Проанализировать

распределение нормальных напряжений по стержням фермы.

2. Выполнить расчет на устойчивость. Посмотреть какие стержни фермы потеряли

устойчивость и объяснить почему.
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3. На основе полученных значений максимальных напряжений и коэффициента

критической нагрузки сделать заключение о прочности. Конструкция должна

удовлетворять следующим требованиям:

 Нормальные напряжения не должны по абсолютной величине превышать 200 МПа;

 коэффициент критической нагрузки не должен быть ниже 1.0.

3. Составить отчет решения задачи, который должен содержать следующую

информацию:

 описание варианта конструкции;

 значения максимальных напряжений и перемещений с указанием наиболее

нагруженных элементов конструкции;

 значения реакций в опорах;

 приблизительные расчеты, подтверждающие отсутствие ошибок в конечно-

элементном расчете;

 результаты расчета на устойчивость;

 заключение о прочности.

2.3.8 Особенности геометрического моделирования ферменной
конструкции
Геометрическая модель ферменной или рамной конструкции должна состоять из

кривых (Curve), проходящих через центры тяжести сечений труб.

Кривые можно построить по заранее созданным точкам вершин фермы в

приложении  с помощью команды Create>Curve>Point.

Кривые, моделирующие длинные ребра фермы, можно разбить по высоте командой

Edit>Curve>Break (рис. 2.3.10) следующим образом.
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Рис. 2.3.10. Окно команды Edit>Curve>Break

 В опции Option существуют возможности Point (разбить по точке), Parametric

(разбить в пропорции), Plane(разбить плоскостью). Достаточно удобно

использовать опцию Parametric, установив в поле Parametric Value нужное

значение параметра разбивки;

 Отключить Auto Execute;

 Выбирать поочередно в поле Curve List разбиваемые кривые;

 Выполнить команду – Apply;

 Проверять выполнение команды подведением мыши к разбитой кривой – должны

загораться отрезки, на которые разбита кривая;

 Если Вы ошиблись, отмените последнюю команду, нажав клавишу .

В результате будут получены отрезки кривых и точки на концах отрезков.

Теперь по точкам – команда Create>Curve>Points - можно построить все

необходимые кривые для геометрической модели фермы.

2.3.9 Задание характеристик материала и свойств элементов

Характеристики материала зададим, как обычно, в приложении . Вызовем

окно команды Create>Isotropic>Manual Input. В поле Material Name нужно задать имя

материала. Нажатием клавиши Input Properties вызовите окно ввода свойств материала и

задайте там значение модуля упругости, коэффициента Пуассона и плотности (Density). В

поле Constitutive Model нужно выбрать Linear Elastic (линейный упругий материал).
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Для создания свойств конечных элементов надо перейти в приложение  и

для создания свойств труб фермы вызвать команду Create>1D>Beam. При выполнении

этой команды сделайте следующее:

 Задайте имя свойства в поле Property Set Name;

 В опции Option выберите General Section (CBEAM) и Standard Formulation;

 нажмите клавишу Input Properties и в появившемся окне задайте имя материала и

имя формы сечения;

 В этом же окне нажатием клавиши Create Sections/Beam Library вызовите окно

Beam Library , пользуясь клавишами , выберите из набора форм сечений

сечение трубы и задайте внешний и внутренний радиус трубы (R1, R2);

 Нажмите клавишу Calculate/Display и проверьте по рисунку сечения на экране,

правильно ли Вы его задали;

 Не забудьте нажать кнопку – Apply;

 Вернувшись в окно команды Create>1D>Beam, в поле Application Region выберите

все кривые (Curve) фермы. Это можно сделать, заключив рисунок фермы на экране

в замкнутую ломаную кривую, используя клавишу  (Polygon);

 Не забудьте нажать кнопку – Apply.

Для создания свойств элементов Mass вызовите команду Create>0D>Mass. При

выполнении этой команды сделайте следующее:

 В окне команды в поле Property Set Name задайте имя свойства или выберите имя

из списка в поле Existing Property Sets;

 В опции Option(s) выберите тип элемента Mass  - Lumped;

 Клавишей Input Properties вызовите окно, в котором задайте значение массы

элемента  Mass – ОК;

 В поле Select Members опции Application Region задайте точки 4-х вершин фермы.

Геометрическая модель фермы, для которой заданы свойства для всех элементов

конструкции, готова к разбиению на конечные элементы.

2.3.10 Создание конечно-элементной сетки
Для создания конечно-элементной сетки труб фермы вызовем окно команды

Create>Mesh>Curve (рис. 2.3.11) приложения .
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Рис. 2.3.11. Окно команды Create>Mesh>Curve

В этом окне сделайте следующее:

 В опции Topology выберите Bar2;

 Отключите Automatic Calculation;

 В поле Value секции Global Edge length задайте длину конечного элемента. Для

того чтобы удовлетворительно описывались формы потери устойчивости, каждый

силовой элемент фермы должен быть разбит не менее чем на 10 элементов. Исходя

из этого соображения, определите нужную в Вашем случае длину элемента;

 В поле Curve List выберите все кривые фермы, пользуясь, например, средством

выбора объектов (Polygon);

 Apply.

В результате будут созданы конечные элементы труб фермы, в полях Node и

Element секции Output ID list появится число созданных узлов и элементов.

Создадим конечные элементы Mass командой приложения 

Create>Element>Edit. В появившемся окне нужно выбрать в поле Select Existing Prop

созданное ранее свойство для элементов Mass, отключить Automatic Calculation и в поле

Node 1 выбрать поочередно узлы 4-х вершин фермы, к которым присоединяется масса.

При разбиении геометрической модели конечно-элементной сеткой, элементы на

разных кривых создаются отдельно друг от друга. Поэтому соседние элементы в точке

соединения кривых будут связаны не с общим узлом, а с несколькими совпадающими

узлами – для каждой кривой свой узел. Для объединения (сшивания) таких совпадающих
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узлов необходимо выполнить команду Equivalence>All>Tolerance Cube приложения

.

2.3.11 Задание закреплений
Опирание конструкции в углах основания можно моделировать двумя способами

(приложение , команда Create>Displacement>Nodal):

 закрепляя точки геометрической модели (при выборе объектов для закрепления

пользоваться опцией Geometry);

 закрепляя узлы конечно-элементной модели (при выборе объектов для закрепления

пользоваться опцией FEM).

Создайте закрепления 4-х углов основания. Способ закрепления выберите сами.

Вид конечно-элементной модели варианта ферменной конструкции показан на

рис. 2.3.12.

Рис. 2.3.12. Конечно-элементная модель фермы

2.3.12 Задание нагрузок

Силу веса можно задать с помощью команды приложения 

Create>Inertial Load>Element Uniform. Для этого в поле New Set Name введите имя
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нагрузки. Вызовите клавишей Input Data окно, где в поле Trans Accel в формате <0 0 0>

задайте ускорение свободного падения (9,82м/сек2) по вертикальной оси фермы.

В результате во время расчета ко всем элементам, обладающим массой,

прикладывается сила веса. Элементы, обладающие массой, это элементы сосредоточенной

массы Mass и элементы других типов, для которых определены плотность и/или

неконструкционная масса.

Плотность является характеристикой материала и должна быть задана при

создании материала или при его модификации в позиции Density. Для стали плотность

равна 7800кг/м3.

Неконструкционная масса предназначена для моделирования не силовых

элементов конструкции, покрытий и т.д., расположенных на конечном элементе.

Неконструкционная масса является характеристикой свойства. Она может быть задана

при создании свойства элемента или при его модификации в позиции Nonstructural

mass/Area (неконструкционная масса на единицу площади) для оболочечных элементов и

в позиции Nonstructural mass/Length (неконструкционная масса на единицу длины) для

линейных элементов (балки, стержни и т.д.).

Ветровая нагрузка представляет собой силы, действующие по направлению ветра

на все стержни фермы. Причем было принято допущение, что погонная сила для всех

стержней одинакова .

Подобную нагрузку можно приложить с помощью команды Create>CID

Distributed Load>Element Uniform приложения  следующим образом:

 В поле New Set Name ввести имя нагрузки;

 В опции Target Element Type выбрать 1D;

 Вызвать клавишей Input Data окно задания величины нагрузки, где в поле Distr

Force в формате <0 0 0> задать вектор погонной силы ветра, а в поле Analysis

Coordinate Frame выбрать систему координат, в которой задаются компоненты

вектора погонной нагрузки;

 В поле Application Region выбрать все кривые (Curve) фермы, заключив рисунок

фермы на экране в замкнутую ломаную кривую, используя клавишу  (Polygon);

 Не забудьте нажать кнопку– Apply;

2.3.13 Запуск расчета на устойчивость

Напомним, что запуск на расчет выполняется через приложение .
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Тип анализа выбирается с помощью клавиши Solution type. Выберите Buckling.

Нажмите последовательно клавиши Solution Parameters и Eigenvalue Extration. В

появившемся окне (рис. 2.3.13) задайте:

 В опции Extration Method (метод решения) выберите – Lanczos;

 В поле Number of Desired Roots число получаемых форм потери устойчивости – 1.

Рис. 2.3.13. Окно задания параметров расчета устойчивости

2.3.14 Отображение результатов
Напоминаем, что для того чтобы посмотреть результаты в системе Patran, нужно

присоединить файл результатов, полученных системой MSC.Nastran, к базе данных Patran

(приложение , команда Attach XDB>Result Entities>Local, клавиша Select Result

File, указать файл с результатами *.xdb, нажать клавишу Apply).

После расчета на устойчивость Nastran создает два результата расчета (Result

Cases) с результатами статического расчета и с результатами расчета на устойчивость.

Статический расчет нужен для вычисления матриц дифференциальной жесткости,

которые используются при расчете на устойчивость.
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Результаты расчета на устойчивость состоят из коэффициентов критической

нагрузки потери устойчивости и форм потери устойчивости.

Величину коэффициента критической нагрузки Eigenvalue можно посмотреть в

окне приложения  в поле Select Result Cases в названии соответствующего Result

Cases (...Mode 1: Factor =). Форма потери устойчивости хранится в векторе Eigenvectors

Translation этого Result Cases и обычно отображается в виде деформаций.

Нарисуйте деформации и напряжения в трубах фермы, полученные в статическом

конечно-элементном расчете, и форму потери устойчивости, полученную в расчете

Buckling.

Виды напряжений, вычисляемые для балочного элемента Beam, приведены в

табл. 2.3.2.

Используйте для этого приложение  и команды Create>Deformation,

Create>Fringe, Create>Quick Plot, работа с которыми подробно разбиралась в

предыдущих задачах.

Таблица 2.3.2. Виды напряжений вычисляемых для балочного конечного элемента

Beam

Опции окна приложения Results

Select Fringe
Result

Quantity Position

Описание

Bar stresses,
Axial

X
Component

– Нормальные напряжения
от растяжения

Von Misses – Напряжения по Мизесу
от растяжения

Max Shear – Максимальный сдвиг для
одноосного

напряженного состояния
Bar stresses,

Bending
X

Component
C,D,E,F Нормальные напряжения

в точках сечения C,D,E,F
от действия

изгибающего момента
Von Misses C,D,E,F Напряжения по Мизесу

от изгиба в точках
сечения C,D,E,F

Max Shear C,D,E,F Максимальный сдвиг для
одноосного

напряженного состояния
в точках сечения C,D,E,F

от изгиба
Bar stresses,
Maximum
Combined

– – Максимальные из
суммарных напряжений
от изгиба и растяжения в
точках сечения C,D,E,F

Bar stresses,
Minimum

– – Минимальные из
суммарных напряжений
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Combined от изгиба и растяжения в
точках сечения C,D,E,F

На рис. 2.3.14 показана первая форма потери устойчивости одного из вариантов

фермы.

Рис. 2.3.14. Первая форма потери устойчивости одного из вариантов конструкции

фермы.

На рис. 2.3.15 приведены деформации одного из вариантов фермы.

Рис. 2.3.16. Деформации фермы под нагрузками

2.3.15 Проверка отсутствия ошибок
Желательно, чтобы способ проверки правильности КЭ-модели ферменной

конструкции Вы придумали сами.
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В качестве рекомендации сравните критическую нагрузку, полученную в конечно-

элементном расчете, с критической нагрузкой для теряющего устойчивость стержня,

полученную по формуле Эйлера:

 2

2

L
EJPкр




 ,

где J – момент инерции сечения, L – длина стержня,  - коэффициент, характеризующий

граничные условия. Нижний конец стержня заделан, а верхний может перемещаться вдоль

оси стержня и поворачиваться с жесткостью, определяющейся изгибной жесткостью

балки. Граничные условия на верхнем конце находятся где-то между ползуном,

двигающимся вдоль стержня с шарниром (как на рис. 2.3.7) и этим же ползуном, но без

шарнира. Коэффициент  для этих граничных условий равен 0,7 и 0,5 соответственно.

2.3.16 Контрольные вопросы
При решении этой задачи Вы познакомились с балочным элементом и элементом

сосредоточенной массы, а также с расчетом конструкции на устойчивость. Кроме того, Вы

должны были освоить некоторые особенности моделирования и отображения результатов

в MSC.Patran. Ниже приведен список контрольных вопросов по этим темам.

1. Балочный элемент Beam в MSC.Nastran. Топология и свойства балочного элемента.

2. Система координат балочного элемента. Задание ориентации балочного элемента.

3. Какие конструкции можно моделировать балочным элементом?

4. Элемент сосредоточенной массы в MSC.Nastran.

5. Понятие потери устойчивости конструкции.

6. Физический смысл коэффициента критической нагрузки и формы потери

устойчивости.

7. Задание закреплений в точках и узлах. Преимущества и недостатки этих двух

способов задания закреплений.

8. Задание инерционных нагрузок в виде ускорения свободного падения.

9. Источники инерционных сил в модели MSC.Nastran.

10. Как запустить расчет на устойчивость?

11. Какие результаты выдает MSC.Nastran для балочных элементов?

12. Какие результаты выдаются после расчета на устойчивость и как их посмотреть?

13. Объясните, почему одни элементы ферменной конструкции сжаты, а другие –

растянуты?

14. Почему, на Ваш взгляд, по первой форме потери устойчивости теряют

устойчивость именно эти элементы фермы в Вашей задаче?
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15. От каких параметров стержня зависит критическая нагрузка потери устойчивости

от сжатия?

2.4 Пример решения задачи №4 “Моделирование и расчет конструкции
стрингерного отсека ракеты-носителя в среде
MSC.Patran/MSC.Nastran”

Целью решения данной задачи является моделирование конструкции стрингерного

отсека ракеты-носителя (РН), выполнение расчетов напряженно-деформированного

состояния и потери устойчивости в линейной постановке.

2.4.1 Задание
Разработать конечно-элементную модель конструкции стрингерного отсека РН,

изображенного на рис. 2.4.1. Исходные данные для моделирования приведены в

табл. 2.4.1. Поперечные сечения подкрепляющих элементов изображены на рис. 2.4.2. В

сечении стыка рассматриваемого стрингерного отсека с верхней частью летательного

аппарата действуют следующие корпусные расчетные нагрузки:

1) продольная сила N = 300 кН;

2) перерезывающая сила Q = 150 кН;

3) изгибающий момент M = 1500 кНм.

Стыковочные шпангоуты изготовлены из сплава АМГ6 (Е = 70000 МПа, т = 160

МПа), а обшивка, стрингеры и промежуточные шпангоуты изготовлены из сплава Д16 (Е

= 75000 МПа, т = 320 МПа).

Рассчитать стрингерный отсек на статическую нагрузку и на устойчивость

(Buckling).

На основе анализа полученных результатов сделать заключение о прочности.

Результаты работы оформить в виде отчета.
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Рис. 2.4.1. Конструкция стрингерного отсека

Рис. 2.4.2. Поперечные сечения стрингера и шпангоутов
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Таблица 2.4.1. Исходные данные для моделирования стрингерного отсека
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2.4.2 Создание геометрической модели стрингерного отсека
Конструкция стрингерного отсека состоит из обшивки, стрингеров и шпангоутов.

Обшивка будет моделироваться оболочечными элементами Shell, а стрингеры и

шпангоуты – балочными элементами Beam.

Геометрические модели для обшивки и для подкрепляющих элементов должны

составлять единое целое, т.к. необходимо, чтобы сетки балочных элементов и

оболочечных элементов можно было сшить между собой. Другими словами, требуется,

чтобы во всех узлах балочных элементов находились и узлы оболочечных элементов. Это

будет выполняться автоматически, если оболочечные элементы будут создаваться на

поверхностях, а балочные – на кривых, являющихся границами этих поверхностей. Узлы

балочных конечных элементов, созданных на кромке поверхности, будут совпадать с

узлами оболочечных элементов, созданных на самой поверхности. При совпадении границ

соседних поверхностей Patran автоматически объединяет их в одну кривую. Это удобно,

так как если бы это было не так, то мы бы имели дело с совпадающими кривыми, на

которых возникли бы совпадающие элементы. Следствием этого было бы увеличение

жесткости силового набора в два раза.

Геометрическая модель, созданная по данной идеологии, будет представлять собой

цилиндрическую оболочку, составленную из прямоугольных поверхностей,
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соответствующих областям обшивки между соседними стрингерами и шпангоутами.

Такую геометрическую модель можно создать следующим образом:

1) войти в приложение ;

2) создать кривую, являющуюся образующей отсека;

3) создать поверхность, соответствующую оболочке между двумя стрингерами (угол

360/Nстр), выполнив над образующей кривой команду создания поверхности

вращения Create>Surface>Revolve. В ходе выполнения этой команды в поле Axis

следует указать ось вращения, в поле Total Angle указать угол поворота и в поле

Curve List – кривую, которую поворачиваем;

4) скопировать созданную поверхность по окружному направлению с помощью

команды Transform>Surface>Rotate. В процессе выполнения этой команды

потребуется ввести вектор, задающий положение оси вращения (поле Axis), число

копий (позиция Repeat Count) и угол, на который будет повернута каждая

последующая копия поверхности относительно предыдущей (поле Rotation Angle);

5) создать плоскости, содержащие в себе промежуточные шпангоуты, командой

Create>Plane>Point Vector. При выполнении этой команды потребуется указать

точку, лежащую в создаваемой плоскости, и вектор, перпендикулярный этой

плоскости;

6) разрезать созданные поверхности по сечениям промежуточных шпангоутов с

помощью команды Edit>Surface>Break. При выполнении этой команды следует

выбрать в списке Option пункт Plane, в поле Surface List выбрать рассекаемые

поверхности, а в поле Break Plane List выбрать плоскость, по которой выполняется

рассечение. Также должна быть выбрана опция Delete Original Surfaces, чтобы

удалить неразрезанные поверхности. Если этого не сделать, ненужные уже

поверхности будут мешать выбирать разрезанные поверхности при выполнении

следующих операций.

2.4.3 Создание конструкционных материалов

Создание материалов производится в приложении  так же, как и в

предыдущих работах за исключением того, что в данной задаче используются два

материала и требуется обязательно задать их плотность. Плотность материала вводится

для того, чтобы можно было автоматически вычислить массу модели конструкции отсека.
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2.4.4 Создание свойств конечных элементов
При решении данной задачи потребуется создать одно оболочечное свойство Shell

для обшивки и три балочных свойства Beam для моделирования силового набора.

Создание оболочечных и балочных свойств обсуждалось при решении задач №1 и №3

соответственно. В данной задаче нужно обсудить только несколько особенностей.

Во-первых, при создании свойств (приложение  команда Create>1D>Beam)

для разных свойств потребуется указывать разные кривые. Для гибкого выбора кривых

рекомендуется использовать команду Preferences>Picking.главного меню системы

(рис. 2.4.3). В окне этой команды обратите внимание на раздел Rectangle/Polygon Picking,

содержащий опции Enclosure Entire Entity (выбор объектов целиком охваченных рамкой)

и Enclosure Any Portion of Entity (выбор объектов частично охваченных рамкой). Кроме

того, при выборе пользуйтесь клавишами Add и Remove секции Application Region,

которые добавляют выбранные объекты в список или убирают их из него соответственно.

Можно также редактировать список выбора вручную, если Вы заметили, например, что он

содержит объект, который Вы не хотели выбирать.

Рис.2.4.3. Окно команды Preferences>Picking  главного меню

Во-вторых, в предыдущей работе было все равно как задавать ориентацию

балочных элементов, поскольку их сечение (труба) было осесимметричным. Теперь же
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ориентация сечения профиля стрингера и шпангоута (поле Bar Orientation в окне Input

Properties команды Create>1D>Beam) должна быть задана строго определенным образом,

чтобы сечения силового набора разместились так, как они размещены в моделируемой

конструкции. Ориентация балочного элемента определяет положение элементной системы

координат (СК) относительно глобальной СК. Ось Х элементной СК направлена от

первого узла балочного элемента ко второму. Направление оси Y можно задавать двумя

способами: вектором, образующим вместе с осью Х элементной СК плоскость XY, и

узлом, лежащим в плоскости XY элементной СК. В отсеке осесимметричной формы

удобно задавать ориентацию либо с помощью узла, лежащего на оси отсека, либо

вектором, направленным по радиальному направлению. Этот вектор для всего силового

набора одновременно можно задать в цилиндрической системе координат, ось Z которой

совпадает с осью отсека.

Направление оси Y элементной системы координат относительно сечения можно

увидеть, выполнив команду Tools>Beam Library главного меню. В появившемся окне

задания параметров поперечных сечений выполнить команду

Modify>Standard Shape>Nastran Standard, выбрать нужное сечение и нажать кнопку

Calculate/Display. Появится окно с изображением поперечного сечения и осью, имеющей

номер 2 и являющейся осью Y элементной системы координат.

Задание ориентации сечения в окне Input Properties команды Create>1D>Beam с

помощью узла выглядит как обычная ссылка на узел (например, “Node 1”), а задание

ориентации вектором может выглядеть следующим образом “< -1 0 0 Coord 1 >”. Если

система координат с номером 1 цилиндрическая, то в этом примере вектор ориентации

направлен вдоль радиального направления внутрь отсека.

Создание новой системы координат выполняется в приложении Geometry с

помощью команды Create>Coord>3Point. При выполнении этой команды нужно:

 в выпадающем списке Type выбрать тип системы координат;

 в поле Origin ввести координаты начала системы координат;

 в поле Point on Axis3 указать координаты точки на оси Z, а в поле Point on Plane1-3

указать координаты точки, лежащей в плоскости XZ (или RZ для цилиндрической

СК).

В-третьих, в этой задаче нужно задавать смещение нейтральной оси балочных

элементов относительно линии узлов. Это смещение задается в окне Input Properties

команды Create>1D>Beam в полях Offset @ Node 1 и Offset @ Node 2 (в нашем случае

концы балочных конечных элементов должны иметь одинаковые смещения и оба эти поля
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должны иметь одинаковые значения). Смещение задается в виде вектора, чтобы

поперечное сечение стрингера заняло положение, показанное на рис. 2.4.4.

Нейтральная ось сечения

Положение линии узлов

ось Y элементной СК

ось Y элементной СК

Положение линии узлов

Нейтральная ось сечения

Смещение нейтральной оси(offset)

Смещение нейтральной оси(offset)

а) Ориентация стрингера

б) Ориентация стыковочного шпангоута

Рис. 2.4.4. Взаимное положение стрингера и обшивки

2.4.5 Создание КЭ сетки

Создание конечно-элементной сетки выполняется в приложении  при

помощи команд Create>Mesh>Surface и Create>Mesh>Curve. При выполнении этих

команд нужно поставить одинаковый размер конечных элементов (в секции Global Edge

Length опция Automatic Calculation должна быть неактивна, а поле Value должно

содержать одинаковый размер элемента). Размер элемента рекомендуется задавать с

таким расчетом, чтобы на меньшей стороне панелей обшивки помещалось 5 элементов.

Это понадобится для хорошего описания формы потери устойчивости каждого элемента

конструкции.

После этого следует объединить сетки оболочечных и балочных элементов, удалив

совпадающие узлы командой Equivalence>All>любой.

При проверке правильности ориентации и смещения профилей силового набора

полезно включить режим отображения поперечных сечений балочных элементов с
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помощью команды главного меню Display>Load/BC/Elem Props и в появившемся окне в

выпадающем списке Beam Display выбрать 2D Mid Span+Offsets.

2.4.6 Особенности закрепления отсека
С общей идеологией задания закреплений для расчетов ракетно-космических

конструкций можно познакомиться в [7].

Стрингерная оболочка по радиальному направлению, как правило, имеет жесткость

намного меньшую, чем по продольному или окружному направлению. Поэтому можно

считать, что по радиальному направлению она не воспринимает нагрузок от

вышестоящего отсека РН и не передает нагрузки нижестоящему отсеку РН. В связи с этим

закрепление отсека по нижнему стыковочному шпангоуту, включающее в себя

закрепление по радиальному направлению, будет вносить ничем не обусловленное

стеснение конструкции. Для того чтобы закрепить нижний стыковочный шпангоут по

всем степеням свободы, за исключением радиального направления, нужно изменить

систему координат закрепляемых узлов на цилиндрическую. Ось Z цилиндрической СК

должна совпадать с продольной осью отсека.

Изменим систему координат закрепляемых узлов на цилиндрическую СК с

помощью команды Modify>Node>Edit из приложения Elements. В появившемся окне

нужно выбрать опцию Analysis Coordinate Frame, и в поле Analysis Coordinate Frame

указать СК, а в поле Node List указать список узлов, у которых мы меняем систему

координат.

При создании закреплений в узлах сечения нижнего стыкового шпангоута (окно

Input Data команды Create>Displacement>Nodal приложения Load/BC) в позиции

Analysis Coordinate Frame нужно выбрать созданную Вами СК. В поле Translations <T1 T2

T3> закрепить все степени свободы кроме перемещения по радиальному направлению

(поступательная степень свободы T1). В поле Rotations <R1 R2 R3> закрепить поворот в

плоскости оболочки (поворот R1).

2.4.7 Особенности приложения нагрузок
Распределение нагрузки, приходящей от верхнего отсека, по сечению верхнего

стыковочного шпангоута, выполним с помощью кинематической связи RBE2 (абсолютно

жесткая кинематическая связь). Для этого в центре сечения верхнего стыковочного

шпангоута создайте узел. В этот узел приложите нагрузку с помощью команды

Create>Force>Nodal приложения Load/BC. Нагрузку из этого узла нужно передать на

узлы верхнего стыковочного шпангоута.
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Передача сил по радиальному направлению запрещается по тем же соображениям,

что и при задании закреплений. Поэтому все узлы, между которыми будет распределяться

нагрузка, должны иметь цилиндрическую СК. Центральный узел, в который

прикладывается нагрузка, не должен иметь базовую цилиндрическую СК, поскольку он

лежит на оси Z этой СК и для него неизвестно где радиальное и где окружное

направление. Система координат этого узла остается базовой.

С помощью команды Create>MPC>RBE2 приложения Elements создайте

абсолютно жесткую кинематическую связь. В окне команды нажмите клавишу Define

Terms. В появившемся окне отметьте опцию Create Independent (независимый) и укажите

в поле Node List узел, в который приложена нагрузка. Потом отметьте опцию Create

Dependent (зависимый). В списке DOFs выберите степени свободы узлов, присоединяемые

к жесткому телу, и укажите в поле Node List узлы, между которыми данная нагрузка будет

распределяться (узлы на верхнем стыковочном шпангоуте).

2.4.8 Создание люка
В реальных изделиях для разных целей приходится регулярную конструкцию

перерезать люками, которые могут существенно влиять на напряжения и деформации.

Попробуйте смоделировать люк в стрингерном отсеке. Сами выберите его

положение и размеры.

Один из способов моделирования люка следующий.

1. Удалите из своей модели стрингерного отсека все конечные элементы вместе с

узлами. Останется геометрическая модель.

2. Создайте в приложении  объемное тело вращения, пересекающее

оболочку отсека по границе люка.

3. Разбейте поверхности оболочки отсека, в которых вырезается люк, по граням

объемного тела с помощью команды Edit>Surface>Break. При выполнении

этой команды следует выбрать из выпадающего списка Option позицию Surface,

в поле Surface List указать разбиваемую поверхность отсека, а в поле Break

Surface List указать поверхность грани объемного тела, по пересечению с

которой будет разбиваться первая поверхность отсека. Разбейте, таким образом,

все поверхности отсека, пересекаемые поверхностью грани объемного тела

люка.

4. В результате этих разбиений возникнет ситуация когда граничная кривая одной

поверхности отсека будет соприкасаться с граничными кривыми двух (может

быть и более) других поверхностей. В этой ситуации нельзя получить точно
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совпадающие конечно-элементные сетки на границах этих поверхностей и

такие сетки нельзя будет “сшить” между собой. Это можно исправить, разбивая

грани таких поверхностей на две командой приложения Geometry -

Edit>Surface>Edge Match. При выполнении этой команды следует выбрать из

выпадающего списка Option позицию Surface-Point, в поле Surface List указать

поверхность, грань которой должна быть разбита на две, а в поле Point List

указать точку, по которой разбивается грань.

5. Удалить поверхности расположенные внутри выреза люка.

6. Добавить в поля Application region свойств оболочечных элементов новые

поверхности, возникшие из-за выреза люка, а в поля Application region свойств

балочных элементов новые кривые.

7. Разбить поверхности и кривые на конечные элементы, сшить конечно-

элементные сетки на них между собой и с кинематической связью. Затем

изменить системы координат для узлов в верхнем и нижнем сечениях оболочки

отсека.

Вид КЭ-модели стрингерного отсека с вырезом приведен на рис. 2.4.5.

Рис. 2.4.5. Конечно-элементная модель стрингерного отсека

2.4.9 Запуск расчета на устойчивость и статику
В соответствии с заданием выполните конечно-элементные расчеты напряженно-

деформированного состояния и потери устойчивости в линейной постановке.

Процедуры запуска на расчет и отображения результатов расчетов обсуждались

при решении предыдущих задач.
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2.4.10 Анализ результатов
Визуализируйте результаты расчетов.

Анализ напряжений в обшивке и стрингерах, значения коэффициента критической

нагрузки потери устойчивости позволяют сделать заключение о прочности

рассматриваемой конструкции стрингерного отсека и предложить меры по изменению

конструкции с целью удовлетворения условиям прочности.

На рис. 2.4.6 – 2.4.8 приведен вид некоторых результатов расчетов.

Рис. 2.4.6. Деформации конструкции отсека под нагрузкой

Рис. 2.4.7. Нормальные напряжения в обшивке
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Рис. 2.4.8. Форма потери устойчивости стрингерного отсека

Проектировщику важно знать укладывается ли он в весовые лимиты. Величина

массы КЭ-модели служит хорошим прогнозом массы конструкции. “Взвешивая”

отдельные части КЭ-модели, можно анализировать массу разных частей конструкции

(стрингеров, обшивки, шпангоутов и пр.). Массу конечно-элементной модели

конструкции называют теоретической массой. Масса реальной конструкции больше, так

как включает так называемые конструкционные привесы (крепеж, мелкие

технологические усиления, несиловые элементы и др.).

Определить массу модели можно с помощью команды Tools>Mass Properties

главного меню, вызвав окно Show 3D, рис. 2.4.9. Нажмите клавишу Define Region. В

появившемся окне в опции Region можно выбрать для взвешивания конечные элементы,

находящиеся в группе (Group), все элементы модели (All) или элементы, выбранные в

список (Selected).

В опции Include можно выбрать в качестве объектов для взвешивания

геометрические объекты (Geometry), конечные элементы (FEM), и те и другие (Both). В

опции Display Method выбрать Summary или Entity. Обратите внимание на появляющиеся

слева от окна меню, облегчающие выбор нужных элементов для взвешивания. Выбрав

элементы для взвешивания, выполните команду, нажав клавишу ОК. В окне команды

Show 3D в выпадающих списках Density/Concentrated Mass (плотность/сосредоточенная

масса) и Thicknesses/Areas/ NSM (толщины/площади/неконструкционные массы) выберите

Use Element Properties (использовать свойства элементов).

В результате на экране появится таблица масс, вид которой показан на рис. 2.4.10.

В столбце Mass указана общая масса.
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Рис. 2.4.9. Окно команды Tools>Mass Properties главного меню

Рис. 2.4.10. Таблица масс

Измерьте отдельно массы обшивки, стрингеров, промежуточных шпангоутов и

стыковочных шпангоутов.

2.4.11 Контрольные вопросы
При решении этой задачи Вы научились моделировать и анализировать силовую

работу довольно сложной конструкции стрингерного отсека в системе MSC.Patran/Nastran.

Ниже приведен список контрольных вопросов по этим темам.

1. Силовая работа стрингерного отсека.
2. Опишите способ построения геометрической модели оболочечных

подкрепленных конструкций, примененный при решении данной задачи.
3. Способы задания ориентации балочных элементов.
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4. Создание закреплений в системе координат пользователя.
5. Приложение корпусных нагрузок к сечению отсека с помощью конечного

элемента абсолютно жесткой связи.
6. Как с помощью Patran взвесить КЭ-модель и ее фрагменты?

2.5 Пример решения задачи №5 “Проектирование конструкции
углесотопластикового головного обтекателя ракеты-носителя в
среде MSC.Patran/MSC.Nastran”

Целью решения этой задачи является моделирование трехслойной конструкции

головного обтекателя ракеты-носителя с использованием конечных элементов типа

Laminate, выполнение расчетов напряженно-деформированного состояния, потери

устойчивости и собственных форм колебаний. Кроме того, требуется подобрать число

слоев однонаправленного углепластика в несущих слоях обтекателя для обеспечения

условий прочности.

2.5.1 Многослойный конечный элемент типа Laminate
Конечный элемент типа Laminate состоит из одного или нескольких слоев. Каждый

слой воспринимает мембранную нагрузку и может иметь свой материал, толщину и

ориентацию материала. Обычно используется для моделирования многослойных

композитных оболочек

Характеристики элемента задаются при определении свойства элемента - команда

Create>2D>Shell. В появившемся окне нужно, в отличие от свойств обычных

оболочечных элементов, в верхнем выпадающем списке Options выбрать пункт Laminate.

В окне задания свойств в поле Material Name нужно выбрать материал типа Composite, а в

поле Material Orientation нужно указать направление, от которого будут откладываться

углы ориентации слоев. Направление указывается либо ссылкой на ось системы

координат, либо вектором.

2.5.2 Собственные колебания
Собственными колебаниями называются колебания конструкции, протекающие

при отсутствии внешних воздействий. Эти колебания характеризуются собственной

формой колебаний и собственной частотой, которые находятся посредством решения

задачи о собственных значениях для динамического уравнения с правой нулевой частью

[8,9]. Перемещения системы при i-м тоне собственных колебаний имеет вид

    )sin( tUu iii   ,

где  u  - вектор перемещений точек конструкции;  iU  - форма собственных колебаний
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по i-у тону; i  - i-я собственная частота; i  - амплитуда колебаний по i-у тону или

модальное перемещение; t – время.

Число собственных колебаний системы равно числу степеней свободы. Чем выше

частота собственных колебаний, тем сложнее собственная форма. Какой тон собственных

колебаний будет возбужден, зависит от вида начального воздействия на конструкцию.

Большинство воздействий, возникающих при эксплуатации конструкций, вызывают

колебания с низшими собственными частотами. Для того чтобы возбудить собственные

колебания с высокими собственными частотами, нужно чтобы начальное воздействие

резко изменялось во времени.

Низшие тона собственных колебаний представляют собой наиболее естественные

для конструкции движения.

Собственные формы и частоты колебаний являются интегральными

характеристиками инерционных и упругих свойств конструкции. Часто требования к

жесткости конструкции РН формулируются в виде ограничения на нижнюю частоту

собственных колебаний.

2.5.3 Конструкция головного обтекателя
Головной обтекатель (ГО) представляет собой трехслойную оболочку, имеющую

форму, представленную на рис. 2.5.1.

 Рис. 2.5.1. Основные размеры конструкции обтекателя

В сечении стыка ГО с ракетой-носителем (РН) на оболочке ГО установлен

стыковой шпангоут. Поперечное сечение шпангоута в реальных конструкциях имеет

довольно сложную форму, и здесь будет моделироваться упрощенно. Представим

шпангоут в виде стенки из алюминиевого сплава, обращенной внутрь оболочки, высотой

100 мм и толщиной 3 мм.
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Трехслойная оболочка состоит из двух несущих слоев углепластика и заполнителя

между ними из металлических сот. Несущий слой, в свою очередь, состоит из 4

однонаправленных слоев углепластика с разной ориентацией относительно продольного

направления: 0, 45, 90, 135. Толщина каждого слоя кратна 0.15 мм (толщина одного

слоя углепластика). Высота сотового заполнителя – 20 мм. Характеристики материалов

сот и однонаправленного слоя углепластика приведены в табл. 2.5.1.

Таблица 2.5.1. Характеристики материалов трехслойной оболочки

Характеристика
материала

Однонаправленный
углепластик

Соты

Нормальный модуль
упругости по 1-му
направлению, Е1 [МПа]

120000 10*

Нормальный модуль
упругости по 2-му
направлению, Е2 [МПа]

8000 10*

Сдвиговой модуль
упругости в плоскости
12, G12 [МПа]

5000 10*

Сдвиговой модуль
упругости в плоскости
23, G23 [МПа]

5000 200

Сдвиговой модуль
упругости в плоскости
31, G31 [МПа]

5000 200

Коэффициент Пуассона ,
12

0.001* 0.001
*

Плотность,  [кг/м3] 1450 65
* Малые значения (вместо нулевых) некоторых
характеристик материала задаются только для того,
чтобы материал не был вырожденным

Неконструкционная масса (NonStructural) оболочки обтекателя – 6 кг/м2.

Неконструкционная масса учитывает массу немоделируемых в данной модели элементов

конструкции: теплозащитное покрытие, замки и профили продольного и поперечного

стыков, слои стеклоткани, наматываемые из технологических соображений, клеи и пр.

2.5.4 Случаи нагружения
Рассмотрим следующие случаи нагружения.

1. Подъем РН на стартовую позицию. Головной обтекатель закреплен в корневом

сечении и нагружен боковой перегрузкой 9.81 м/с2.

2. Аэродинамическое давление на участке выведения. Cлучай симметричного

обтекания. Зависимость давления от продольной координаты следующая:



97

 на сферической части ГО давление изменяется линейно с 70 КПа на переднем

конце ГО до 30 КПа на границе с конической частью;

 на конической части ГО давление изменяется линейно с 30 КПа на переднем конце

конической части до 10 КПа на границе с цилиндрической частью;

 на цилиндрической части ГО давление постоянно и составляет –5 КПа. Знак минус

означает, что на этом участке давление действует изнутри ГО.

3. Аэродинамическое давление на участке выведения при максимальном скоростном

напоре (случай “max q”). Распределение давления по половине оболочки

обтекателя для этого случая приведено в табл. 2.5.2. Распределение давления по

другой половине симметрично первой половине.

Таблица 2.5.2. Распределение давления по оболочке обтекателя для случая “max q”

Окружная координата, градПоперечное сечение
0 90 180

Передний конец
обтекателя

60 кПа 60 кПа 60 кПа

Стык сферической и
конической частей
обтекателя

60 кПа 50 кПа 40 кПа

Стык конической и
цилиндрической частей
обтекателя с передней
стороны

20 кПа 15 кПа 5 кПа

Стык конической и
цилиндрической частей
обтекателя с задней
стороны

5 кПа -5 кПа -10 кПа

Основание обтекателя 5 кПа 0 кПа -5 кПа

2.5.5 Критерии прочности
1. Напряжения для всех слоев углепластика по направлению волокон не должны

превышать допустимых - 100 МПа.

2. Коэффициент критической нагрузки потери устойчивости не должен быть меньше

1.0.

3. Нижняя частота собственных колебаний не должна быть ниже 10 Гц.

2.5.6 Задание
1. Разработать КЭ модель головного обтекателя. Размеры ГО для разных вариантов

конструкции приведены в табл. 2.5.3.

2. Провести линейный статический расчет, анализ начальной потери устойчивости

для рассматриваемых случаев нагружения и анализ собственных колебаний.
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3. В случае если конструкция не удовлетворяет условиям прочности или, наоборот,

удовлетворяет с большим запасом, предложить новые толщины слоев углепластика

и проверить новый вариант конструкции на прочность. Толщина слоев

углепластика должна быть кратна толщине углеленты, из которой они

изготавливаются – 0.15 мм.

Таблица 2.5.3. Варианты конструкции головного обтекателя

Номер
варианта

D, мм L, мм L1 , мм L2 , мм R,
мм

1 4000 12000 0.7* L 0.1* L 0.5
2 2500 8500 0.7* L 0.1* L 0.5
3 3500 10000 0.7* L 0.1* L 0.7
4 3500 9000 0.7* L 0.2* L 1.0
5 4100 11000 0.7* L 0.2* L 1.0
6 4000 12000 0.5* L 0.1* L 0.5
7 2500 8500 0.5* L 0.1* L 0.5
8 3500 10000 0.5* L 0.1* L 0.7
9 3500 9000 0.5* L 0.2* L 1.0
10 4100 11000 0.5* L 0.2* L 1.0

2.5.7 Геометрическая модель конструкции головного обтекателя
Поскольку и конструкция и нагрузки симметричны относительно плоскости угла

атаки, ожидается, что и решение будет симметричным. В этом случае можно

моделировать не весь обтекатель, а только его половину.

Геометрическую модель обтекателя можно строить разными способами.

Один из них следующий.

1. Создать кривые (Curve), которые вращением вокруг продольной оси обтекателя

образуют форму обтекателя.

2. Построить поверхности (Surface) по этим кривым – команда Create>Surface>Revolve.

Причем поворот выполнить на 90 градусов, поскольку поворот сразу на 180 градусов

может привести к некоторым сложностям при создании конечно-элементной сетки.

3. Скопировать построенные в предыдущем пункте поверхности поворотом на 90

градусов (команда Transform>Surface >Rotate).

Вид геометрической модели одного из вариантов ГО показан на рис. 2.5.2.
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Рис. 2.5.2. Вид геометрической модели обтекателя

2.5.8 Создание свойств конечных элементов и материалов
Следует создать материалы для однонаправленного углепластика и сот (см.

табл. 2.5.1), а также для торцевого шпангоута. Создать материалы нужно в приложении

Materials.

Материалы для однонаправленного углепластика и сот – ортотропные.

Ортотропные материалы создаются командой Create>2D Orthotropic>Manual Input.

Задание характеристик ортотропного материала на примере сот показано на рис. 2.5.3.

Далее следует создать композиционный материал с помощью команды

Create>Composite>Laminate. При выполнении этой команды в специальной форме,

показанной рис. 2.5.4, задаются материалы, толщины и ориентации слоев.

Как создать свойство торцевого шпангоута Вы уже знаете из примера решения

задачи №4.

Создание свойства многослойной оболочки рассмотрено при описании элемента

Laminate в разделе 2.5.1. Отметим только, что следует создать разные свойства для

разных частей оболочки: конической, сферической, цилиндрической и цилиндрической

корневой. Эти части оболочки нагружены по-разному и, возможно, потребуется задавать

для них разные толщины несущих слоев.



100

Рис. 2.5.3. Окно задания характеристик для ортотропного материала

Рис. 2.5.4. Окно задания характеристик для многослойного композиционного

материала

2.5.9 Создание конечно-элементной сетки
Создание конечно-элементной сетки производится таким же образом, как в

предыдущей работе (см. раздел 2.4.5).
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Вид конечно-элементной модели одного из вариантов обтекателя показан на

рис. 2.5.5.

Рис. 2.5.5. Вид конечно-элементной модели обтекателя

2.5.10 Создание закреплений
Модель ГО закрепляется за сечение стыка с РН по всем степеням свободы, кроме

направления по нормали к оболочке. Такое закрепление приблизительно соответствует

условиям, в которых работает головной обтекатель, установленный на РН. Закрепления

следует прикладывать в цилиндрической системе координат, ось Z которой совпадает с

продольной осью ГО. Для этого нужно сделать следующее.

1. Создать цилиндрическую систему координат, у которой продольная ось

совпадает с продольной осью модели обтекателя – команда

Create>Coord>3Point приложения Geometry.

2. Сменить систему координат закрепляемых узлов с системы координат Coord 0

на созданную цилиндрическую систему с помощью команды Modify>Node>Edit

приложения Elements, модифицируемый параметр Analysis Coordinate Frame.

3. При задании закреплений с помощью команды Create>Displacement>Nodal

приложения Loads/BCs указать в окне Input Data в поле Analysis Coordinate

Frame созданную цилиндрическую систему координат.

Если рассматривается половина конструкции, нужно задать дополнительно

закрепления, моделирующие плоскость симметрии обтекателя. Узлы в плоскости

симметрии не могут выходить из этой плоскости, а также не могут поворачиваться вокруг

осей, лежащих в плоскости симметрии, поскольку такой поворот означал бы выход из

плоскости симметрии точек рядом с узлом. Таким образом, у узлов, находящихся в
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плоскости симметрии, должны остаться незакрепленными только поступательные

перемещения в плоскости симметрии и поворот вокруг нормали к плоскости симметрии.

2.5.11 Задание нагрузок
Нагрузки на обтекатель в данной работе содержат несколько случаев нагружения.

Создаваемые нагрузки и закрепления попадают в активный случай нагружения модели

(Load Case). При создании новой модели в системе Patran автоматически создается случай

нагружения с именем Default (по умолчанию). В предыдущих работах все создаваемые

нагрузки и закрепления попадали в этот случай, что было приемлемо т.к. конструкции в

этих работах рассчитывались для одного случая нагружения. Кроме того, при запуске на

расчет случай Default выбирается как расчетный по умолчанию. Поэтому при запуске на

расчет в команде Analysis>Entire Model>Full Run не было надобности указывать, для

какого случая нагружения выполняется расчет. Из-за того, что в этой работе случаев

нагружения несколько, придется создавать случаи нагружения самим и явно указывать

при запуске на расчет, для какого случая нагружения он будет выполняться.

Случаи нагружения создаются в приложении Load Cases командой Create. Сменить

активный случай нагружения можно в процессе выполнения любой команды создания или

модификации нагрузок и закреплений в приложении Loads/BCs. Кроме того, перечень

нагрузок и закреплений для случая нагружения можно задать при создании случаев

нагружения (команда Create приложения Loads/BCs) и модификации (команда Modify

приложения Loads/BCs). Для этого нужно нажать клавишу Assign/Prioritize Loads/BCs. С

помощью этих команд убедитесь, что заданное ранее закрепление содержится во всех

случаях нагружения.

Приложение нагрузок в виде перегрузки рассматривалось при решении задачи №3

(раздел 2.3.12) и здесь останавливаться на этом не будем.

Для задания давления, переменного по поверхности обтекателя, сначала требуется

задать закон изменения давления в виде поля (Field) системы Patran. Создать поле,

задающее закон изменения давления от координат элемента, можно с помощью команды

Create>Spatial>Tabular Input (создание пространственного поля заданием таблицы

значений) приложения Fields. При выполнении этой команды следует выбрать систему

координат, в которой будет задаваться поле, и координаты, от которых будет зависеть

значение поля. В табл. 2.5.2 давление задается в зависимости от продольной и окружной

координаты цилиндрической системы координат. Далее, нажав кнопку Input Data,

вызывается окно, содержащее таблицу, в которой левый столбец и в случае двух

переменных верхняя строка служат для ввода значений координат, а остальное поле

таблицы служат для ввода значений поля. Ввод значений осуществляется следующим
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образом: выделяется ячейка таблицы, которую вы решили заполнить, а потом в поле Input

Scalar Data вводится значение, которое последующим нажатием кнопки Enter посылается

в выделенную ячейку. Значения координат должны вводиться в эту таблицу в порядке

возрастания. Поле для второго случая нагружения будет зависеть от одной координаты

(продольной), а поле для третьего случая нагружения – от двух координат.

Приложение давления задается командой Create> Pressure >Elemental. При

выполнении этой команды следует задать имя нагрузки, в выпадающем списке выбрать к

каким элементам будет прикладываться давление к оболочечным (2D) или объемным (3D)

элементам. В окне Input Data задать величину давления в поле Top Surface Pressure или

значением (при постоянном давлении) или выбрав в списке Spatial Fields поле, задающее

закон изменения давления от координат элемента. В поле Load/BC Scale Factor можно

задать множитель, на который будет умножено значение поля. Эту возможность можно

использовать, например, в случае если давление в поле было задано не в тех единицах

измерения, в каких должно прикладываться давление. В регион приложения давления

рекомендуется выбирать не геометрические поверхности, а конечные элементы (опция

FEM, в поле Element List, список элементов), поскольку, как показывает опыт, приложение

переменного давления на геометрические объекты, не всегда работает корректно.

2.5.12 Запуск расчетов
Запуск на расчет производится командой Analysis>Entire Model>Full Run

аналогично предыдущим работам, за исключением того, что необходимо выбрать случаи

нагружения (клавиша Subcase Select). Кроме того, требуется дополнительный заказ

результатов расчета по напряжениям в слоях, который делается через кнопку Subcases.

Здесь нужно выбрать действие Create, в списке Available Subcases выбрать расчетный

случай (одноименный со случаем нагружения), для которого нужно заказать напряжения в

отдельных слоях композиционного материала, затем нажать клавишу Output Request. В

появившемся окне в выпадающем списке Form Type выбрать пункт Advanced, в списке

Output Requests выбрать строчку, начинающуюся со слова STRESS (напряжение), и после

этого в выпадающем списке Composite Plate Opt выбрать пункт Ply Stresses (выдача

напряжений для слоев элементов Laminate).

Расчет собственных колебаний включается выбором опции Normal Modes,

доступной через кнопку Solution Type. Расчетный случай для этого расчета должен

содержать закрепление в стыке с обтекателем и закрепления условия симметрии.

В результате расчета собственных колебаний должно появится 10 результатов,

содержащих собственные формы колебаний, названия которых содержат собственные

частоты. Число вычисляемых тонов собственных колебаний задаются при запуске на
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расчет последовательным нажатием кнопок Subcases, Subcase Parameters и изменением

значения числа тонов в поле Number of Desired Roots

2.5.13 Анализ результатов расчетов
Некоторые результаты по напряженному состоянию для элемента Laminate,

выдаваемые MSC.Nastran, приведены в табл. 2.5.4.

Таблица 2.5.4. Результаты, выдаваемые MSC.Nastran для элементов Laminate
Тип напряжений
в слое элемента

Laminate

Описание

X Component Нормальные напряжения по
направлению оси Хм в слое

Y Component Нормальные напряжения по
направлению оси Yм в слое

XY Component Касательные напряжения в
плоскости XмYм слоя

YZ Component Касательные напряжения в
плоскости YмZм слоя

XZ Component Касательные напряжения в
плоскости ZмXм слоя

Max Principal 2D Максимальные главные напряжения
в слое

Min Principal 2D Минимальные главные напряжения
в слое

Max Shear Максимальные касательные
напряжения в слое

Von Mises Эквивалентное напряжение по
Мизесу (характеризует деформацию
изменения формы)

Tresca 2D Эквивалентное напряжение по
Треске

Напряжения для элементов Laminate вычисляются в системе координат, связанной

с ориентацией материала в слое элемента. Поскольку ориентация материала в разных

слоях элемента может быть различной, для каждого слоя напряжения выдаются в своей

системе координат. Система координат, связанная с ориентацией материала, строится

следующим образом: ось Хм повернута относительно системы координат элемента на

угол ориентации материала и совпадает таким образом с первым направлением

ортотропного материала; ось Yм лежит в плоскости элемента, перпендикулярна оси Хм и

совпадает со вторым направлением ортотропного материала; ось Zм перпендикулярна

плоскости элемента.

На рис. 2.5.6 – 2.5.11 приведены примеры некоторых результатов расчетов.

Определите массу обтекателя. Для этого нужно воспользоваться командой

Tools>Mass Property главного меню.
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Выведите на экран в виде заливки напряжения во всех зонах оболочки для всех ее

слоев по направлению волокна в слое, а также форму и критическую нагрузку потери

устойчивости, формы и частоты собственных колебаний.

Сравните эти результаты с требованиями прочности. В случае невыполнения

требований прочности, увеличьте толщину слоев углепластика. Какие слои и в каких

зонах оболочки обтекателя следует увеличивать, определите на основе анализа

результатов расчетов. В случае, если условия прочности для какой-либо зоны оболочки

обтекателя выполняются с большим запасом, уменьшите направления укладки в несущем

слое с 4-х до 3-х. Например, можно перейти к укладке 0, 60, 120 или 30, 90, 150.

Снова «взвесьте» обтекатель и определите, какую массу конструкции Вам удалось

съэкономить.

Рис. 2.5.6. Деформированное состояние обтекателя под нагрузкой на фоне

недеформированной конструкции
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Рис. 2.5.7. Несущий слой оболочки. Нормальные напряжения в углеволокне слоя,

ориентированного под углом 0 град к продольной оси обтекателя
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Рис. 2.5.8. Несущий слой оболочки. Нормальные напряжения в углеволокне слоя,

ориентированного под углом 45 град к продольной оси обтекателя
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Рис. 2.5.9. Несущий слой оболочки. Нормальные напряжения в углеволокне слоя,

ориентированного под углом 90 град к продольной оси обтекателя
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Рис. 2.5.10. Несущий слой оболочки. Нормальные напряжения в углеволокне слоя,

ориентированного под углом 135 град к продольной оси обтекателя
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Рис. 2.5.11. Первая форма потери устойчивости носовой части оболочки обтекателя

2.5.14 Контрольные вопросы
При решении данной задачи Вы научились моделировать силовую работу

головного обтекателя ракеты, познакомились с элементом многослойной оболочки

Laminate и с расчетом собственных колебаний, а также попробовали уменьшить массу

конструкции, не нарушая требований прочности. Ниже приведен список контрольных

вопросов по этим темам.

1. Конечный элемент Laminate. Свойства. Угол ориентации материала.

2. Что такое собственные колебания?

3. Плоскость симметрии конструкции и КЭ-модели. Закрепления, соответствующие

плоскости симметрии.

4. Способы приложения давления к КЭ-модели в программе Patran.

5. Силовая работа трехслойной оболочки.

6. Какие изменения в конструкцию оболочки Вы внесли для удовлетворения

требования прочности и снижения ее массы?

2.6 Пример решения задачи №6 “Моделирование наезда автомобиля на
препятствие в среде MSC.Patran/MSC.Nastran”

При проектировании транспортных средств, и в частности автомобилей, параметры

силовой схемы определяются, в том числе, динамическими нагрузками. Среди

динамических случаев нагружения, на которые нужно рассчитывать и испытывать

конструкцию автомобиля, можно привести столкновение автомобиля с препятствием,

наезд автомобиля на неровность дороги, регулярные периодические неровности дороги,

вызывающие вынужденные колебания корпуса и т.д. Данные нагрузки могут быть

реализованы в системе MSC/Nastran в рамках линейного и нелинейного анализов
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переходных процессов, а также в рамках анализа вынужденных колебаний. В данной

лабораторной работе предлагается провести моделирование наезда автомобиля на

препятствие.

2.6.1 Постановка задачи
Требуется рассчитать перемещение несущей конструкции автомобиля при наезде

на неровность дороги. Для упрощения моделирования и сокращения вычислительных

затрат будем считать, что нагрузка в данном случае воспринимается только несущей

рамой, и кузов автомобиля принимает участие в работе конструкции в незначительной

мере. Чертеж конструкции несущей рамы и подвески приводится на рисунке 2.6.1.

Несущая рама представляет собой конструкцию, набранную из балок коробчатого

поперечного сечения. В четырех точках к раме крепится двигатель. Четыре рессоры

связывают раму с осями колес. Поперечные сечения балок рамы, рессор и осей колес

приведены на рисунке 2.6.2.

Рисунок 2.6.1. Чертеж несущей рамы автомобиля с подвеской

Основные характеристики рассматриваемого автомобиля следующие:

 Размеры a и b, а также общая масса автомобиля для разных вариантов задания

приводятся в таблице 2.6.1;
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 Масса двигателя – 300 кг;

 Материал осей колес, балок рамы и рессор – сталь (Е=210000 МПа , =0.3,

=7800 кг/м3);

 Демпфирование в рессорах взять 0,75 от критического (C/C0=0.75).

Таблица 2.6.1. Значения a и b и общей массы автомобиля для разных вариантов задания
Вариант a, мм b, мм М, кг Вариант a, мм b, мм М, кг

1 800 897,5 6 387 1000,0

2 1000 939,8 7 300 911,8
3 1400 1024,3 8 400 1013,2
4 1600 1066,6 9 500 1114,7
5 1800

387

1108,9 10

1285

600 1216,1

Необходимо найти колебания конструкции в зависимости от времени при наезде на

препятствие, изображенное на рисунке 2.6.3. Скорость движения автомобиля – 50 км/ч.

Характеристики препятствия: максимальная высота Н = 0,1 м; длина L = 1м.

Рисунок 2.6.2. Поперечные сечения несущей рамы
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Рисунок 2.6.3. Зависимость уровня дороги от времени при переезде через кочку высотой H

и длиной L со скоростью V

2.6.2 Геометрическое моделирование
Конечно-элементную модель конструкции предлагается сделать балочной и в

таком случае геометрическая модель должна состоять из кривых. Геометрическое

моделирование будет похоже на то, каким это было в лабораторной работе по

моделированию вышки (разд. 2.3). Поэтому подробно на создании геометрической модели

останавливаться не будем, а приведем список команд, которые могут понадобиться (см.

таблицу 2.6.2).

Таблица 2.6.2. Описание некоторых команд приложения Geometry, предназначенных для
работы с кривыми и точками

Команда
Action Object Method

Описание Исходные данные

Create Point XYZ Построение точки Координаты точки в квадратных
скобках (например [0.,0.5,100.])

Create Curve- Points Построение прямой линии
по точкам

Выбрать точки на экране или указать
их координаты как в предыдущей

команде
Transform Curve Translate Копирование кривых вдоль

вектора
Номера кривых; координаты вектора.

Число повторений.
Transform Curve Mirror Копирование кривых

посредством отражения
относительно плоскости

Номера кривых; плоскость отражения.
Смещение копии вдоль нормали к

плоскости отражения.
Edit Curve Break Разбить кривую на две Номера кривых; координаты точки, по

которой кривые будут разбиваться на
две.

Transform Point Translate Копирование точек вдоль
вектора

Номера точек; координаты вектора.
Число повторений.

Delete Point --- Стереть точки Номера точек

Delete Curve ---- Стереть кривые Номера кривых

2.6.3 Свойства и материалы
Нужно определить два материала: материал несущей рамы и осей колес и материал

рессор. Оба эти материала будут иметь одинаковые упругие и инерционные

характеристики (смотри задание), но для материала рессор необходимо определить

коэффициент демпфирования (поле Damping).

Далее следует создать свойства балочных элементов для рамы автомобиля,

рессоры и оси колес. Создание свойств балочных элементов подробно рассматривалось в
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лабораторных работах про вышку (раздел 2.3) и про стрингерный отсек (раздел 2.4.). Это

команды приложения Property Create>1D>Beam для создания и Modify>1D>Beam для

изменения. Обратите внимание на ориентацию сечений балочных элементов. Проверить

правильность ее задания можно будет после создания конечно-элементных сеток на

кривых. Для этого следует отобразить  сечения с помощью команды главного меню

Load/BC/Elem.Props… . В появившемся окне установить опцию Beam display в положение

3D Full Span+Offsets.

Кроме того, нужно создать свойство массового элемента для двигателя (команды

приложения Property Create>0D>Mass опция Lumped для создания и Modify>0D>Mass для

изменения). В области применения свойства следует указать либо заранее созданный в

центре масс двигателя точечный элемент (приложение Elements, команда

Create>Element>Edit, опция Shape в позиции Point). Можно также указать геометрическую

точку, а затем создать точечный элемент в этой точке.

2.6.4 Создание конечно-элементной сетки
Количество элементов вдоль кривой, напомним, можно сделать командой

Create>Mesh Seed>Uniform приложения Elements. Размер конечных элементов должен

быть таким, чтобы достаточно точно описывать изгиб балок рамы и оси. Для этого на

одну балку должно приходиться не менее 5 элементов. Однако, такие элементы

конструкции как узлы крепления рессор (короткие широкие выступы, к концам которых

крепятся рессоры), могут моделироваться одним элементом, так как они, ввиду своей

малой длины, не могут испытывать значительных деформаций и присутствуют в модели

только для передачи силы от рессоры к раме. Поперечное сечение узлов крепления рессор

может быть задано таким же, как поперечное сечение балок рамы, к которым узлы

крепления рессор крепятся.

После задания атрибутов для кривых (Mesh>Mesh Control>Attributes Along Curve),

определения размеров конечных элементов (Mesh>Mesh Control>Size Along Curve) и

создания конечно- элементной сетки (Mesh>Geometry>Curve) необходимо произвести

сшивку узлов (приложение Elements, Equivalence>All>Tolerance Cube).

Далее требуется создать конечный элемент сосредоточенной массы (тип MASS),

моделирующий массу двигателя (если еще не создан). Считаем двигатель абсолютно

жестким и присоединим массовый элемент к узлам крепления двигателя посредством

кинематической связи RBE2. Эта связь представляет собой абсолютно жесткое тело и

создается командой приложение Elements, команда Create>MPC>RBE2 (см.рисунок 2.6.4).
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Рисунок 2.6.4. Задание абсолютно жесткой связи

При выполнении этой команды необходимо задать независимый узел (включив

опцию Create Independent). Степени свободы этого узла будут определять перемещения

абсолютно жесткого тела. Включив опцию Create Dependent, следует задать зависимые

степени свободы – степени свободы, перемещения которых управляются движением

абсолютно жесткого тела.

Теперь необходимо учесть массу кузова автомобиля, который в данной работе

предлагается не моделировать, но массу которого необходимо учесть. Массу кузова

предлагается равномерно распределить по несущей раме в виде неконструкционной массы
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(в поле Nonstructural Mass). В окне задания свойств балочных элементов задается

неконструкционная масса на единицу длины элемента. Для того чтобы определить

значение погонной неконструкционной массы, нужно знать, во-первых, массу кузова, а

во-вторых, длину всех балок несущей рамы. Масса кузова может быть определена как

разность общей массы автомобиля и массы всех конечных элементов модели (рамы,

рессоры, оси и двигатель)

Взвесить конечные элементы модели можно с помощью команды главного меню

Tools>Mass Properties>Show>3D, выбрав группу по умолчанию (Default group).

Узнать суммарную длину кривых, соответствующих несущей раме, можно с

помощью приложения Geometry, команда Show>Curve>Atributes. После назначения

неконструкционной массы необходимо снова взвесить модель, чтобы убедиться, что масса

модели равна массе автомобиля.

После того как общая масса модели стала соответствовать заданию, осталось

только внести некоторое исправление в крепление рессоры к несущей раме. Если крепить

рессору с обоих концов к раме по всем степеням свободы, то она будет представлять

собой довольно жесткую плоскую ферму. Поскольку рессора должна быть весьма упругой

один ее конец не крепят по направлению продольной оси автомобиля (см. рисунок 2.6.4).

Закрепленная таким образом рессора работает на изгиб в отличие от фермы, элементы

которой работают на растяжение и сжатие. Для того чтобы смоделировать данное

крепление рессоры к раме, нужно разъединить конечно-элементную сетку в одной из

точек крепления рессоры к раме. Это можно сделать следующим образом:

Создаем дополнительный узел в одной из точек крепления рессоры (приложение

Elements, команда Create>Node>Edit);

Затем редактируем элемент на конце рессоры так, чтобы старый узел этого

элемента, прикрепленный к раме, заменить на только что созданный узел (приложение

Elements, команда Modify>Element>Edit, выбрать опцию Connectivity, выбрать

редактируемый элемент, в поле Current Node List указать узел который следует заменить,

а в поле New Node List указать узел на который производится замена). В результате этого

в разъединенной точке крепления будет два совпадающих узла: один из них будет

принадлежать к несущей раме, а второй – к рессоре.

Соединить совпадающие узлы между собой кинематической связью абсолютно

жесткого тела RBE2. При этом для зависимого узла выбрать все степени свободы

поступательного перемещения вдоль продольной оси автомобиля.
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Рессора

Несущая рама

Рессора крепится к
раме по всем
степеням свободы

Рессора крепится к раме по
всем степеням свободы
кроме поступательных

перемещений вдоль
продольной оси автомобиля.

В данной точке  нужно
разъединить конечно-

элементную сетку и вставить
эдемент типа Rigid

Рисунок 2.6.4. Крепление рессоры к несущей раме

2.6.5 Задание закреплений
Закрепление предлагается выполнить следующим образом: концы осей колес

закрепить по вертикальному направлению и вдоль оси колес. После этого рекомендуется

выполнить анализ собственных колебаний (приложение Analysis команда Analysis >Entire

Model>Full Run, нажав кнопку Solution Type выбрать тип анализа - Normal Modes).

Просмотрев формы собственных колебаний можно проверить модель на наличие ошибок.

2.6.6 Задание нагрузок
Нагрузка на модель представляет собой вынужденные перемещения одного из

колес во времени. Точка на конце колеса перемещается в вертикальном направлении в

соответствии с законом, приведенном на рисунке 2.6.3. Предлагается сделать это

следующим образом.

1. Создать поле типа NonSpatial, аргументом которого является время:

a) Приложение Fields;

b) Команда Create, NonSpatial, Tabular Input;

c) Ввести имя поля и выбрать в качестве аргумента время;

d) Нажать кнопку Input data и в появившемся окне кнопку Map Function to

Table;

e) Ввести зависимость для формы препятствия, указанной на рисунке 2.6.3, в

поле PCL expression, начальное и конечное время в полях Start time и End time, а

также количество точек для табулирования данной функции в поле Number of

Points;

f) Выйти из всех окон нажимая кнопки Apply и Ok.

2. Сменить тип случая нагружения со статического на динамический:

a) Приложение Load Cases;
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b) Команда Modify;

c) Выбрать случай нагружения;

d) Изменить значение поля Load Case Type на Time Dependent;

e) Нажать кнопку Apply.

3. Создать перемещение, зависящее от времени:

a) Приложение Loads/BCs;

b) Команда Create, Displacement, Nodal;

c) Ввести в поле Translations вектор, содержащий 1.0 по вертикальному

перемещению,,и пропуски по остальным перемещениям, в поле Time/Frequency

Dependence нужно выбрать созданное ранее поле;

d) Отредактировать закрепления так чтобы они не противоречили

перемещению колеса при переезде через кочку.

2.6.7 Выполнение расчета
Выполнение расчета производится командой Analysis >Entire Model>Full Run

приложения Analysis. Нажав кнопку Solution Type выберите тип анализа Transient response

и, нажав здесь же кнопку Solution parameters, в поле W4 damping factor нужно задать

первую собственную частоту, перемноженную на 2 (это задается характерная частота

колебаний, необходимая для преобразования конструкционного демпфирования в вязкое).

Далее, вернувшись в окно приложения Analysis, нажмите кнопку Subcases. В появившемся

окне в поле Available subcases выберите существующий расчетный случай (Default) или

введите имя нового расчетного случая. Выберите случай нагружения для расчетного

случая в окне Available Load Cases. Нажав кнопку Solution parameters задайте шаг

интегрирования (Delta-T), число шагов (No of Time Steps) и через какое количество шагов

выдавать результаты (Skip factor). После чего нажать кнопку Apply, а затем Cancel. Нажав

кнопку Select Subcase выбрать расчетный случай и нажав кнопку Apply запустить расчет.

2.6.8 Просмотр результатов
Результаты анализа переходных процессов представляют собой ряд записей

откликов (Result Case). Каждая запись содержит перемещения конструкции в один из

моментов времени, и все вместе они дают представление о колебаниях конструкции во

времени. Динамическое поведение системы удобно отображать в виде анимации по

нескольким записям и в виде графиков.

Предлагается построить график вертикальных перемещений точки приложения

нагрузок, центра масс двигателя и график вертикальных перемещений в точке установки
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кресла водителя. Кроме того, предлагается отобразить анимацию перемещений во

времени.

Для того чтобы построить график, нужно выполнить следующие действия:

1. Выполнить команду Create>Graph>Y vs X приложения Results и в секции Select

Results (левая кнопка вверху окна приложения) в поле Select Results Cases

выбрать записи откликов, соответствующие результатам, опцию Y установить в

положение Result, в поле Select Y Results выбрать перемещения (Displacements)

и опцию Quantity установить в положение, соответствующее вертикальному

перемещению. Опцию X установить в положение Global Variable, а опцию

Variable установить в положение Time;

2. Перейти в секцию Target Entities (вторая слева кнопка вверху окна

приложения). Здесь следует указать для перемещений каких узлов будут

построены графики. Это можно сделать, установив опцию Target Entity в

положение Nodes и выбрав в поле Select Nodes узлы, для которых нужно

построить графики;

3. Нажмите кнопку Apply.

Для того чтобы отобразить анимацию перемещений во времени, нужно выполнить

следующие действия:

1. Настроить изображение на вид с моделью, а именно убрать все лишние объекты

(точки, кривые, узлы и т.д.) для снижения времени на прорисовку вида;

2. Выполнить команду Create>Deformation приложения Results и в секции Select

Results (левая кнопка вверху окна приложения) в поле Select Results Cases

выбрать записи откликов, соответствующие результатам, а в поле Select

Deformation Results выбрать перемещения (Displacements). После этого

выберите опцию Animation;

3. Перейти в секцию Animation Options (правая кнопка вверху окна приложения) и

установить опцию Animation Method в положение Global Variable. В поле Select

Global Variable выбрать время (Time), а в поле Numbers of Frames установить

количество кадров. Если установить количество кадров, равное количеству

записей откликов, то анимация будет наилучшего качества, но может медленно

работать, если количество откликов велико. В этом случае количество кадров

следует уменьшить. После этого нажмите кнопку Apply;

Снизить время, необходимое для вывода анимации на экран, можно с помощью

уменьшения размеров вида.
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2.7 Пример решения задачи №7 “Моделирование силовой работы
фланцевого соединения двух стрингерных отсеков с учетом
контакта между фланцами в среде MSC.Patran/MSC.Nastran”

Здесь рассматриваются соединения частей конструкции с помощью дискретных

узлов креплений, таких как болты, замки и т.д. Эти крепежные элементы, как правило,

прижимают друг к другу специальные элементы конструкции соединяемых частей,

именуемые фланцами. Предполагается, что сила передается таким соединением через всю

площадь фланца. Это предположение справедливо, если равнодействующая сила,

передаваемая соединением, проходит по оси болта или замка. В таком случае сила

прижатия постоянна по всей площади фланца, и если сила натяжения болта или замка

достаточна, чтобы под нагрузкой удерживать фланцы прижатыми, то сила будет

проходить через всю поверхность фланца. Иначе возможно частичное раскрытие

фланцевого соединения, что приводит к концентрации силы в соединении на части

фланца, что приведет к увеличению напряжений и может оказаться критичным. Основная

трудность при моделировании конструкции с фланцевым соединением заключается в

определении справедливости допущения о равномерной передаче нагрузки через площадь

фланца. Установить через какую часть фланца будет передаваться нагрузка, можно только

проведя нелинейный расчет с учетом контакта между фланцами. Такой нелинейный

расчет представляет собой итерационный процесс, в ходе которого после каждой

итерации заново определяется зона контакта, и матрица жесткости перестраивается с

учетом текущей конфигурации этой зоны. Этот расчет займет много времени и

необязательно решение будет найдено с первой попытки (итерационный процесс может

не сойтись).

Совпадения оси болта и равнодействующей силы в соединении можно добиться

выбором места установки болта (например, при соединении двух цилиндрических отсеков

болты можно установить на том же радиусе что и центра тяжести стрингеров).

Эффективным также является установка развитых косынок, которые подводили бы силу к

болту, сводя к минимуму работу фланца на изгиб.

Подводя итоги можно выделить две ситуации, возникающие при моделировании

разъемных соединений:

1. Правильная работа – равнодействующая сила идет по оси болта, фланец почти

не испытывает изгибных деформаций, благодаря установленным в окрестности

болта достаточно развитым ребрам жесткости. В этом случае соединение

работает просто, нет концентраций напряжений и возможна идеализация такого
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соединения в КЭ-модели. Например, можно считать фланцы жестко

присоединенными друг к другу по всей поверхности.

2. Неправильная работа – сила идет не по оси болта и/или фланец недостаточно

подкреплен ребрами жесткости и испытывает большие изгибные деформации.

В таком случае невозможно считать фланцы прижатыми по всей поверхности.

При моделировании таких соединений возможны два варианта. Первый вариант

– считать, что вся сила передается через один болт. Допущение об отсутствии

устойчивого контакта между фланцами является часто допущением в запас с

точки зрения прочности. Жесткость такой модели занижена, а напряжения в

окрестности соединения завышены из-за дополнительной работы на изгиб

деталей соединения. Второй вариант – провести исследование области

прижатия фланца с помощью нелинейного статического анализа для наиболее

тяжелых случаев нагружения. В результате анализа будет получено

распределение давления фланцев друг на друга по поверхности фланцев. После

этого следует КЭ-модель для линейных расчетов сделать такой, чтобы силы

через разъемные соединения передавались сходным образом.

КЭ-модель для нелинейного статического расчета должна состоять из моделей

обоих фланцев, болты могут моделироваться балочными элементами, шпильки

точечными элементами. По всей поверхности фланцы должны соединяться друг с другом

контактными элементами, имеющими высокую жесткость при сблизившихся друг к другу

контактирующих узлах и не имеющих жесткости при отдалившихся контактирующих

узлах. Натяжение болтов может быть смоделировано температурными деформациями

балочных элементов, моделирующих болты. В системе MSC.Nastran это можно

выполнить с помощью контактных элементов CGAP.

В этой работе будет проведено моделирование силовой работы фланцевого

соединения двух стрингерных отсеков с учетом контакта между фланцами.

2.7.1 Исходные данные
В этой работе предлагается рассчитать силовую работу фланцевого соединения

двух стрингерных отсеков. Для простоты считаем, что конструкция этих двух отсеков

одинакова – одно и тоже число стрингеров, одна и та же толщина обшивки, оба отсека –

цилиндрические оболочки одного диаметра. Геометрические размеры стрингера и

стыкового шпангоута те же что и в работе №4. В аэрокосмической технике применяются

различные конструкции фланцевых соединений (см рисунок 2.7.1). В этой работе

предлагается рассмотреть работу трех наиболее простых вариантов конструкции –
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первого, второго и четвертого. Параметры конструкции отсеков для разных вариантов

задания приведены в таблице 2.7.1. Модель должна включать в себя как само фланцевое

соединение, так и прилегающие к соединению части стрингерных отсеков. Для

предложеных вариантов будет достаточно рассмотреть прилегающие к соединению части

стрингерных отсеков длиной 1000 мм.

Нагрузки в верхнем сечении модели взять такими же как в работе 4.

 1) 2) 3)      4)      5)

Рисунок 2.7.1 – Варианты исполнения фланцев

Таблица 2.7.1. Исходные данные для моделирования фланцевого соединения
Вариант
конструкции

Диаметр отсека, D,
мм

Число стрингеров,
Nстр

Вариант
конструкции

1 24
2 36
3 40
4 48

1

5 24
6 36
7 40
8 48

2

9 24
10 36
11 40
12

2600

48

4

2.7.2 Создание геометрической модели
Геометрическая модель должна состоять из моделей соединяемых фланцевым

соединением отсеков. Поскольку на силовую работу фланцевого соединения

непосредственное влияние оказывают только прилегающие к соединению части отсеков, в

этой работе будут моделироваться только эти части стрингерных отсеков. Геометрическая
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модель должна иметь вид, сходный с моделью стрингерного отсека в лабораторной работе

№4. Обшивке отсека должны соответствовать поверхности, на которых будет создана

сетка оболочечных изгибных элементов. Кривые на границах поверхностей должны

совпадать с положением стрингеров и шпангоутов и на этих кривых будут созданы

балочные конечные элементы, моделирующие силовой набор. Однако стыковые

шпангоуты фланцевого соединения должны быть смоделированы подробнее. Стыковой

шпангоут представляет собой уголок, одна полка которого прилегает к обшивке, а другая

лежит в плоскости, перпендикулярной оси отсека. Обе эти полки предлагается

моделировать оболочечными элементами. Тогда геометрическая модель должна

содержать поверхности, соответствующие полкам стыковых шпангоутов.

Предлагается следующий порядок создания геометрической модели (все

используемые команды находятся в приложении Geometry):

1. С помощью команды Create>Curve>Points создать образующую отсека (кривую,

вращением которой вокруг продольной оси отсека можно получить

поверхность оболочки отсека). Продольную ось отсека совместить с осью Х

глобальной системы координат, а плоскость YZ сделать плоскостью

соприкосновения фланцев. При построении образующей следует учесть, что

конец образующей кривой, прилегающий к фланцевому соединению должен

отстоять от плоскости соприкосновения фланцев на половину толщины полки

стыкового шпангоута, перпендикулярной оболочке отсека (далее полка_1).

Этот отступ должен быть сделан, потому что поверхности оболочечных

элементов, которые будут моделировать полку_1, будут располагаться на

расстоянии половины их толщины относительно поверхности расположения

узлов;

2. Поворачивая образующую вокруг оси Х на угол равный углу между соседними

стрингерами создать поверхность, соответствующую обшивке между

стрингерами (Create>Surface>Revolve);

3. Размножить полученную в пункте 2 поверхность на половину оболочки отсека

(Transform>Surface>Rotate). Моделируем только половину отсека, поскольку

конструкция закрепления и нагрузки симметричны относительно плоскости

изгиба конструкции и, следовательно, решение ожидается тоже симметричным.

В этом случае можно моделировать только половину модели, а отброшенную

половину заменить граничными условиями симметрии. Это снизит

вычислительные затраты;

4. Создать образующую кривую для полки_1;



121

5. Разбить образующую кривую на две по радиусу установки болтов

(Edit>Curve>Break);

6. Повторить пункты 2 и 3 для образующих кривых полки_1;

7. С помощью команды Create>Plane>Point-Vector создать плоскость,

содержащую в себе границу полки стыкового шпангоута, лежащей на обшивке

(далее полка_2);

8. Рассечь все поверхности оболочки отсека плоскостью, созданной в

предыдущем пункте (Edit>Surface>Break, в списке Option выбрать Plane);

9. Создать поверхности соответствующие полкам стрингера с помощью команды

выдавливания (Create>Surface>Extrude). Полка стрингера перпендикулярная

оболочке образуется одной поверхностью, а полка прилегающая к оболочке

должна быть образована двумя поверхностями, ширина которых равна

половине ширины этой полки (см. рисунок 2.7.2);

10. Удалить образующие обшивки и полки_1 (Delete>Curve);

11. Создать геометрическую модель второго стрингерного отсека отражением

геометрическую модели первого стрингерного отсека относительно плоскости

фланцевого соединения (Transform>Surface>Mirror);

12. Создать кривые для болтов. Соединить противолежащие точки пересечения

четырех поверхностей на полках_1 прямой линией. Повернуть эту линию

поворотом вокруг оси отсека на угол, равный половине угла между соседними

стрингерами (Transform>Curve>Rotate). С помощью этой же команды

размножить эту линию поворотом вокруг оси отсека на угол, равный углу

между соседними стрингерами.



122

Рисунок 2.7.2 – Моделирование стрингера оболочечными элементами
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2.7.3 Задание материалов и свойств
Конструкция отсеков сделана из алюминиевого сплава (Е=70000 МПа, =0.3,

=2700кг/м3). Болты во фланцевом соединении стальные (Е=210000 МПа, =0.3,

=7800кг/м3). Создадим эти материалы с помощью команды приложения Materials

Create>Isotropic>Manual Input.

Нужно создать четыре оболочечных свойства для следующих элементов

конструкции: обшивка отсека, полка_1, полка_2 совместно с обшивкой отсека

(приложение Property, команда Create>2D>Shell). При задании последнего свойства

необходимо задать смещение элемента относительно узлов, если расположить элементы

как указано на рисунке 2.7.3. Смещение задается в поле Offset. В этой работе предлагается

моделировать стрингеры оболочечными элементами и следует также создать оболочечные

свойства для полок стрингеров.

При выборе поверхностей для регионов приложения свойств полезно переключать

режим выбора объектов рамкой. С помощью команды главного меню Preferences>Picking

можно установить три режима:

1. Выбор полностью охваченных рамкой объектов (Enclose entire entity);

2. Выбор частично охваченных рамкой объектов (Enclose any portion of entity);

3. Выбор объектов, чьи центра оказались внутри рамки (Enclose centroid).

Кроме того, удобным средством выбора объектов является использование групп.

Распределение объектов модели по разным группам в зависимости от того, каким

элементам конструкции эти объекты (геометрические объекты или конечные элементы)

позволяет более гибко выбирать объекты при выполнении команд. Каждый объект может

находиться только в одной группе. В начале работы все объекты содержатся в группе

Default Group (группа по умолчанию). В таблице 2.7.2 приводятся некоторые команды по

работе с группами. Доступ к этим командам через главное меню.

Таблица 2.7.2 - Команды по работе с группами
Команда

Главное
меню

Action Method
Описание Исходные данные

Group Create Select
Entity

Создание группы Имя группы, перечень объектов
входящих в группу (если не указывать
получится пустая группа) , Сделать ли

группу текущей (все новые объекты
помещаются в текущую группу)

Group Post- --- Определение списка групп,
отображаемых на виде

Список групп, отображаемых на виде

Group Modify --- Модификация группы перечень объектов добавляемых или
удаляемых из группы.

Group Set
Current

--- Выбор текущей группы Имя текущей группы.

Group Delete --- Стереть группу Имя удаляемой группы.
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 – Узлы Середина толщины полки_1

Середина толщины обшивки

Середина толщины полки_2
совместно с обшивкой

Смещение полки_2
совместно с обшивкой
относительно линии узлов

Рисунок 2.7.3. Расположение оболочечных конечных элементов в зоне стыкового

шпангоута

Далее создадим свойство балочных элементов для моделирования болтов отсека

(приложение Property, команда Create>1D>Beam). Причем следует учесть, что длина

балочного элемента в модели будет вдвое меньше чем длина болта от шляпки до гайки

(см. рис 2.7.4). Следовательно, если задать поперечное сечение балочного элемента

соответствующим сечению болта и упругие характеристики материала болта задать в

соответствии с действительностью, то жесткость болта в модели на растяжение будет в

два раза выше, чем в реальности. Для устранения этого несоответствия предлагается

уменьшить модуль упругости материала болта вдвое (приложение Materials, команда

Modify>Isotropic>Manual Input).
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Рисунок 2.7.4. Моделирование болтов

Для создания свойства контактного элемента GAP необходимо знать жесткость

контактирующих частей конструкции. Поэтому создание этого свойства отложим до

момента, когда будет готова конечно-элементная модель, позволяющая эту жесткость

выяснить.

2.7.4 Создание конечно-элементной сетки
Характерная деформация обшивки в стрингерном отсеке – выпучивание обшивки

между двумя соседними стрингерами. Форма этого выпучивания имеет по окружному

направлению вид половины синусоиды. Для описания такой деформации достаточно 5

элементов между соседними стрингерами (обычно берут 10 элементов на период

гармоники). Но поскольку болты у нас будут стоять посередине между стрингерами, то

желательно, чтобы количество элементов между соседними стрингерами было бы четным.

Хорошим компромиссом здесь будет четыре элемента между стрингерами. Этот размер

годится для всей модели кроме разбиения полок стыкового шпангоута по

меридиональному направлению, где рекомендуется более подробная сетка, а именно 4

элемента на ширину и полки_1 и полки_2. Эти размеры можно задать следующим

образом:

1. Назначить всем кривым такой размер, чтобы между стрингерами помещалось

четыре элемента (приложение Elements, команда Create>Mesh Seed>Uniform). При

выполнении этой команды выбор опции Number of Elements позволяет задать

количество элементов, а выбор опции Elements Length позволяет задать длину

элементов. Измерить расстояние между точками можно с помощь приложения

Geometry, команда Show>Point>Distance.
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2. Удалить размеры элементов с тех кромок поверхностей, образующих полки

стыкового шпангоута, которые лежат в меридиональном направлении (Delete>

Mesh Seed).

3. На одном из торцов стыкового шпангоута назначить размеры элементов в

меридиональном направлении так, чтобы по ширине обеих полок было четыре

элемента. Этот размер распространим на весь шпангоут при использовании

алгоритма разбиения Isomesh.

4. Создать конечно-элементную сетку на поверхностях (Create>Mesh>Surface,

опция Mesher должна быть установлена в положение Isomesh, а опция Automatic

Calculation - отключена).

5. Сшить совпадающие узлы Equivalence >All>Tolerance Cube.

6. Создать конечно-элементную сетку на кривых (Create>Mesh>Curve). Списки

кривых, на которых следует создавать элементы, можно копировать из свойств.

7. Еще раз сшить совпадающие узлы Equivalence>All>Tolerance Cube.

2.7.5 Задание граничных условий
Поскольку, благодаря симметрии в данной задаче, моделируется половина

конструкции, необходимо в плоскости симметрии задать граничные условия симметрии.

Условия симметрии представляют собой закрепление поступательных перемещений,

перпендикулярных плоскости симметрии, а также все повороты кроме поворота вокруг

перпендикуляра к плоскости симметрии.

Нижний край нижней стрингерной оболочки нужно закрепить по всем степеням

свободы.

2.7.6 Создание контакта между фланцами
Для задания параметров контактных элементов требуется измерить жесткость

контактирующих частей конструкции. Для определения этой жесткости создадим

специальный тестовый случай нагружения. Приложим во все узлы нижнего фланца

единичные силы в продольном направлении (приложение Loads/BCs, команда

Create>Force>Nodal). Измерив перемещения фланца под действием этих сил, вычислим

жесткость между точками на фланце и закреплением на нижнем краю модели. Выполним

линейный статический расчет (приложение Analysis, команда Analyse>Entire Model >Full

Run). Загрузив результаты (Access Results>Attach XDB>Result Entities), отобразим

перемещения модели вдоль оси Z в виде векторов (приложение Results, команда Create

Marker>Vector). Перемещения вдоль оси Z являются продольными, поскольку мы задали

узлам цилиндрическую систему координат, а для маркеров перемещения отображаются по
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степеням свободы узлов без предварительного перевода в глобальную (Coord 0) систему

координат. Жесткость фланца определяется как отношение единичной силы к

перемещению точки фланца.

Теперь мы можем задать свойство контактного элемента (приложение Properties,

команда Create>1D>Gap). Следует указать следующие свойства контактного элемента:

1. Вектор ориентации, позволяющий построить систему координат элемента (Gap

Orientation). Можно указать любое направление, не совпадающее с нормалью к

поверхности контакта;

2. Начальный зазор (Initial Opening), при начальном положении фланцы прижаты

друг к другу и начальный зазор равен 0;

3. Жесткость элемента при наличии контакта (Closed Stiffness) рекомендуется

задавать, равной жесткости контактирующих поверхностей, перемноженной на

1000;

4. Жесткость элемента при отсутствии контакта (Opend Stiffness) рекомендуется

задавать, равной жесткости контактирующих поверхностей, деленной на 1000;

Создать сами контактные элементы можно следующим образом:

Создать новую пустую группу (Group>Create>Select Entities), и сделать ее текущей

(Group>Create>Set Current). Все элементы, которые мы создадим, попадут в эту группу, и

нам их легко будет выбирать. Создать элементы между противолежащими узлами

фланцев, расположенных на одном из краев фланцев на границе с плоскостью симметрии

конструкции (приложение Elements, команда Create>Element>Edit, в поле Shape выбрать

Bar, в поле Topology выбрать Bar2). Размножим эти несколько элементов на всю

поверхность фланцев с помощью копирования поворотом вокруг продольной оси отсека

(приложение Elements, команда Transform>Element>Rotate). Затем отобразим только

группу с контактными элементами (Group>Post). И, наконец, поместим эти элементы в

свойство контактных элементов (приложение Properties, команда Modify>1D>Gap).

Пришьем новые элементы к остальной модели (приложение Elements, команда

Equivalence>All>Tolerance Cube).

2.7.7 Задание нагрузок
Поскольку случай нагружения Default («по умолчанию») использовался нами для

тестового случая нагружения, создадим новый – расчетный – случай нагружения

(приложение Load Cases, команда Create), поместим туда все закрепления и не станем

помещать тестовую нагрузку. Этот новый случай нагружения будет реализовывать натяг

болтов. Натяг будет моделироваться сжатием болтов при охлаждении. Для этого

вычислим коэффициент температурного расширения  болта, соответствующий
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некоторому заданному напряжению натяга в болте н. Деформации при температурном

расширении зависят от изменения температуры T следующим образом

   Tu  1 .

Деформации и напряжения связаны законом Гука  u
l
E , где l – длина болта, а

E - модуль упругости материала болта.

Будем считать, что при затяжке болта в нем возникает напряжение 200 МПа, а

перепад температур T примем равным 1. Вычислите коэффициент температурного

расширения  и внесите его в материал болта (приложение Materials, команда

Modify>Isotropic>Manual Input, поле Termal Expan/Coeff). После этого создайте

температурную нагрузку –1 во всех узлах модели (приложение Loads/BCs, команда

Create>Temperature>Nodal). Кроме того, во всех узлах модели следует задать начальную

температуру равную 0 (приложение Loads/BCs, команда Create>Initial

Temperature>Nodal).

Второй случай нагружения будет включать в себя как натяг, так и корпусные

нагрузки на конструкцию. Приложение сначала натяга, а потом внешней нагрузки

соответствует реальной истории нагружения, и будет способствовать лучшей сходимости

итерационного процесса по сравнению с приложением и натяга и внешних нагрузок

одновременно. Создайте еще один случай нагружения и поместите в него все закрепления,

температурные нагрузки и начальную температуру. Создадим внешние корпусные

нагрузки на конструкцию.

Осевая, перерезывающая силы и изгибающий момент в верхнем сечении модели

такие же, как в работе №4. Создадим в центре верхнего сечения узел (приложение

Elements, команда Create>Node>Edit) и соединим его с узлами на оболочке, лежащими в

этом сечении, двумя абсолютно жесткими кинематическими связями (приложение

Elements, команда Create>MPC>RBE2). Одна из них должна соединить центральный узел

со всеми степенями свободы узлов, не лежащих в плоскости симметрии. Другая должна

соединить центральный узел с продольным и радиальным перемещениями и поворотом

вокруг окружного направления двух узлов в плоскости симметрии. В обеих связях

центральный узел сделать независимым. Центральный узел следует добавить в граничное

условие симметрии и приложить к нему нагрузку, аналогичную нагрузке в работе № 4.

2.7.8 Выполнение расчета
Решение контактной задачи выполняется с помощью алгоритма нелинейной

статики. Для того чтобы применить этот алгоритм, необходимо изменить балочные



129

свойства с эксцентриситетами (приложение Property, команда Modify>1D>Beam). В нашей

задаче это свойства стрингера и промежуточного шпангоута. Переключите опцию справа

от поля Section Name в положение Properties и отключите «крыжик» Associate Beam

Section внизу формы задания свойств. Затем удалите смещения балочных элементов из

полей Offset Node1 и Offset Node2. Внесите эти смещения в поля Y of NA@Node1 , Z of

NA@Node1, Y of NA@Node2 и Z of NA@Node2. Заметим, что раньше смещения

задавались в одной из глобальных систем координат, а в этих четырех полях смещения

должны задаваться в местной системе координат элемента.

При запуске расчета (приложение Analysis, команда Analyse>Entire Model >Full

Run) в разделе Solution Type выберите алгоритм Nonlinear Static. В диалоге Subcases для

расчетного случая с корпусной нагрузкой с помощью кнопки Output Requests запросите

выдачу сил в элементах (Elemental Force), а также, установив опцию Form Type в позицию

Advanced, а опцию Intermediate Output (промежуточная выдача результатов) в позицию

All. В диалоге Select Subcases нужно выбрать последовательно расчетный случай с

натягом и расчетный случай с натягом и внешней нагрузкой. После этого запустите расчет

кнопкой Apply.

2.7.9 Анализ результатов
Загрузите результаты расчета (приложение Analysis, команда Access Results>Attach

XDB>Result Entities). Если модель не содержала ошибок, результаты должны содержать

две группы записей откликов (Result Case). Одна группа содержит напряженно-

деформированные состояния на разных стадиях затяжки болтов, а вторая группа -

напряженно-деформированные состояния на разных стадиях приложения корпусной

нагрузки. И в первой и во второй группе запись откликов, название которой содержит

“100%”, соответствует полной затяжке болтов и полностью приложенной внешней

нагрузке. Внешняя нагрузка может приложиться не полностью. Это может произойти из-

за потери устойчивости при нагрузках ниже внешних нагрузок. В таком случае анализ

передачи сил через фланцевое соединение проводите по последней записи откликов или

по предпоследней записи, если деформации в последней записи сильно искажены потерей

устойчивости.

Передачу силы через фланцевый стык можно показать либо с помощью заливки

(приложение Results, команда Create>Quik Plot) или с помощью векторов (приложение

Results, команда Create Marker>Vector). Отобразите силы в контакте (Gap Results, Force).

Посмотрите какая часть поверхности фланцев участвует в передаче сил через соединение.
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На рисунке 2.7.4. показана конечно-элементная модель фланцевого соединения

двух отсеков с контактными элементами. На этом рисунке показаны деформации

конструкции в области соединения, стрелочками показаны усилия в контактных

элементах.

Рисунок 2.7.4 – Моделирование силовой работы фланцевого стыка с учетом

неполного контакта между фланцами
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Заключение
Лабораторный практикум позволяет освоить работу в системе

MSC.Patran/MSC.Nastran, а также познакомиться с особенностями решения различных

задач с помощью метода конечных элементов. При подготовке практикума использовался

опыт конечно-элементного моделирования, накопленный на кафедре летательных

аппаратов при выполнении хоздоговорных работ. Лабораторный практикум полезен для

студентов претендующих на получение звания магистра.
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